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는 것으로 해석하지 말아야 합니다. HP는 이 문서의 기술적, 편집상 오류나 누
락에 대해 책임을 지지 않습니다.

이 문서에 포함된 정보는 예고 없이 변경될 수 있습니다.

제한적 권리 범례
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문서 업데이트
이 설명서의 제목 페이지에는 다음과 같은 식별 정보가 포함되어 있습니다.

• 소프트웨어 버전을 표시하는 버전 번호

• 문서를 업데이트할 때마다 변경되는 문서 릴리즈 일자

• 이 소프트웨어 버전의 릴리즈 일자를 표시하는 소프트웨어 릴리즈 일자

최근 업데이트를 확인하거나 최신 에디션 사용 여부를 확인하려면 다음 URL
을 방문하십시오.

http://ovweb.external.hp.com/lpe/doc_serv/

적절한 제품 지원 서비스를 신청하여 업데이트 또는 새 에디션을 받으실 수도 
있습니다. 자세한 내용은 HP 대리점에 문의하십시오.
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지원
다음 HP OpenView 지원 웹 사이트를 방문해 보십시오.

http://www.hp.com/managementsoftware/support

이 웹 사이트에는 HP OpenView가 제공하는 제품, 서비스 및 지원에 대한 연락
처 정보와 세부사항이 기재되어 있습니다. 

HP OpenView 온라인 소프트웨어 지원은 고객이 직접 문제를 해결하는 기능을 
갖추고 있으며, 빠르고 효율적인 방식으로 대화형 기술 지원 도구에 액세스하
여 비즈니스를 관리할 수 있습니다. 이 지원 사이트를 활용하는 소중한 지원 
고객들이 누릴 수 있는 혜택은 다음과 같습니다.

• 관심 분야의 지식 문서 검색
• 온라인으로 개선 요청사항 제출
• 소프트웨어 패치 다운로드
• 지원 사례 제출 및 진행상황 추적
• 지원 연락처 관리
• HP 지원 연락처 검색
• 가용 서비스에 관한 정보 검토
• 다른 소프트웨어 고객과의 토론 참여
• 소프트웨어 교육 검색 및 등록

대부분의 지원 서비스는 HP Passport 사용자로 등록하여 로그인해야만 사용할 
수 있습니다. 지원 계약이 필요한 서비스도 많습니다.

액세스 수준에 대해 자세히 알아보려면 아래 사이트로 이동하십시오.

http://www.hp.com/managementsoftware/access_level

HP Passport ID를 등록하려면 아래 사이트로 이동하십시오. 

http://www.managementsoftware.hp.com/passport-registration.html
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1 개요

이 장에서는 관리된 서비스 수준 계약에 따라 SLM 요원이 서비스를 모니터링
하고 서비스에 대한 SLM 보고서를 작성하도록 하는 서비스 수준 매니저 기능
을 개괄적으로 설명합니다.
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개요

서비스 수준 매니저란?
서비스 수준 매니저란?
서비스 수준 매니저는 조직이 서비스 수준 관리 절차를 채택할 수 있도록 여러 
기능을 제공합니다. 서비스가 합의된 서비스 수준으로 고객에게 제공되고 있
는지 서비스 모니터링 어플리케이션에서 측정 항목 어댑터로 수집한 측정 항
목 데이터 값을 기반으로 준수 여부를 모니터링하고 평가합니다.

서비스 수준 매니저를 사용하는 조직은 다음과 같은 활동을 하게 됩니다. 

• SLM 관리자는 서비스 수준 매니저가 필요로 하는 구성 요소를 설치, 
구성, 유지합니다.

• 서비스 디자이너는 사양 내에 측정 항목과 목표가 포함된, 재사용할 수 
있는 서비스 정의를 작성합니다.

• 서비스 관리자는 서비스 정의 또는 계층 필터를 기반으로 모니터링된 서
비스를 작성합니다. 서비스 계층에는 서비스를 고객에게 전달하는 데 사
용되는 IT 인프라 구성 요소를 나타내는 모든 구성 항목과 하위 서비스가 
포함됩니다.

• SLM 요원은 서비스의 현재 준수 상태를 모니터링하고, 현재 평가 기간 끝 
부분에 달성될 서비스의 준수 상태를 예측하고, 서비스의 현재 가용성과 
주목해야 할 구성 항목을 모니터링합니다. 

• SLM 요원은 가용성 및 준수 상태 변경에 따라 자동으로 트리거링되는 
경보 인시던트에 대응합니다. 

• SLM 요원은 이전 평가 기간 또는 현재 진행 중인 평가 기간의 평가 보고서
를 인쇄하거나 온라인으로 확인합니다.

• 서비스 사용자는 사용하려는 서비스의 현재 가용성을 확인합니다. 
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개요

서비스 수준 매니저 기능
서비스 수준 매니저 기능
여기에서는 주요 기능의 개요를 알아봅니다.

추가 객체 및 확장

서비스 수준 매니저는 서비스, 서비스 정의, 구성 항목(CI)과 같은 기본 객체뿐 
아니라 측정 항목 어댑터, 계층 필터, 서비스 수준 목표와 같은 추가 기본 객체
에 대한 확장을 제공합니다.

추가 객체 및 확장을 통해 고객에게 제공하려는 서비스에 대해 다음과 같은 정
보를 지정할 수 있습니다.

• 서비스 계층 내 각 CI의 가용성을 측정하는 방식을 결정하는 측정 항목 및 
목표

• 각 서비스의 준수를 측정하는 방식을 결정하는 측정 항목 및 목표

• 함께 사용하여 구성 항목 성능을 측정하고, 가용성 및 준수 계산/보고를 위
해 이러한 측정 결과를 전달하는 모니터링 어플리케이션, 관리 서버, 측정 
항목 어댑터에 대한 세부사항

가용성 및 준수 계산의 결과는 양식 및 뷰에 자동으로 표시되며, 사용자는 
현재 평가 기간 동안 가용성과 준수를 계속 모니터링할 수 있습니다.

서비스 디자인 기능

서비스 디자이너는 재사용할 수 있는 서비스 정의에 대한 측정 항목과 목표를 
지정할 수 있습니다. 서비스 관리자가 특정 서비스 정의를 기반으로 모니터링
된 서비스를 작성할 때마다, 계층 내 각 구성 항목은 각 항목이 기반으로 하는 
정의에서 측정 항목과 목표를 자동으로 계승합니다. 서비스 수준을 선택하여 
서비스를 제공하려면 더 높은 서비스 수준을 포함하는 좀 더 까다로운 목표에 
적극적인 서비스 정의를 제공할 수 있습니다. 

서비스 수준 매니저는 복잡한 서비스 정의 계층 구축 작업과 가장 복잡한 서비
스 정의 계층에서 측정 항목과 목표를 지정하는 작업을 간소화하는 서비스 디
자인 기능을 제공합니다.
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개요

서비스 수준 매니저 기능
계층 내 객체에 대한 측정 항목과 목표가 완전히 정의되었는지 보여주는 그래
픽 표시를 사용하여 서비스 정의 계층을 작성할 수 있습니다. 그림 1-1은 서비
스 정의 계층의 예를 보여줍니다.

그림 1-1 서비스 정의 계층의 예

서비스 정의를 기반으로 작성한 모니터링된 서비스는 그래픽으로 표시할 수 
있으며, 이를 통해 계층 내 객체가 완전히 정의되었는지 확인할 수 있습니다. 

서비스 모델링 기능

CI 대 CI 관계, CI 범주 등으로 업데이트하는 방식으로 자체 CMDB(구성 관리 
데이터베이스)를 유지하는 조직에서 서비스 디자이너는 계층 필터를 사용할 
수 있습니다. 특정 계층 필터를 기반으로 하는 서비스는 필터에서 정의한 서비
스 계층을 자동으로 계승합니다. 
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개요

서비스 수준 매니저 기능
서비스 모델링 기능은 계층 필터 작성 작업을 간소화합니다. 대화형 그래픽 인
터페이스를 통해 어떤 CMDB 요소가 서비스 계층에 포함되는지 결정하는 필
터 규칙을 추가, 수정, 삭제할 수 있습니다. 그래픽 미리보기 창에는 특정 
기본 객체 및 현재 포함된 필터 규칙에 대한 서비스 계층이 표시됩니다.

리프 노드를 지정하여 서비스 계층을 잘라낼 수 있습니다. 리프 노드는 서비스 
계층에서 하위 구성 요소가 없는 구성 요소입니다. 서비스 계층을 잘라내면 
CMDB에서 삭제하지 않고도 가용성 및 준수 계산에서 구성 항목을 제외할 수 
있습니다. 이러한 구성 항목의 예로는 비필수 백업 서버를 들 수 있습
니다. 그림 1-2는 계층 필터의 예를 보여줍니다.

그림 1-2 계층 필터의 예
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개요

서비스 수준 매니저 기능
가용성 및 준수 계산

서비스 수준 매니저는 서비스 수준 계약의 각 평가 기간에 걸쳐 가용성과 준수 
상태 계산을 반복 실시합니다. 계산은 설치된 측정 항목 어댑터가 전달한 측정 
항목 데이터 값을 수신하면 트리거링됩니다. 

서비스 수준 매니저는 다음 내용을 계산합니다.

• 서비스 수준 계약 및 서비스의 준수 상태

• 지금부터 현재 평가 기간 끝까지 예상되는 서비스 수준 계약 및 서비스의 
예측 준수 상태

• 서비스 및 구성 항목의 현재 가용성

가용성 및 준수 경보

서비스 수준 계약, 서비스, 구성 항목에 영향을 미치는 가용성 및 준수 상태가 
변경되면 SLM 요원에게 자동으로 알리도록 경보를 설정할 수 있습니다.

계산으로 인해 객체의 가용성 또는 준수 상태가 변경될 때마다 패밀리 경보 인
시던트가 자동으로 작성됩니다. 인시던트에는 상태 변경에 관한 모든 관련 정
보가 들어 있습니다. 

SLM 관리자는 경보를 트리거링하는 상태 변경 유형을 구성할 수 있습니다. 

경보 인시던트 생성에 따라 실행되는 데이터베이스 규칙을 작성할 수 있습니
다. 작성하는 규칙은 서비스 수준 매니저 또는 작업 그룹 전문가에게 이메일을 
보내거나 HP OpenView 작동 메시지를 생성하는 액션을 트리거링할 수 있습니
다.

서비스 수준 계약의 관리

서비스 수준 매니저가 서비스의 준수 상태 및 가용성 계산을 시작하기 전에 서
비스를 서비스 수준 계약과 연결하고 SLM 관리 하에 SLA를 두어야 합니다. 
SLM 서버 프로세스를 재시작한 후, 가용성 및 준수 계산은 서비스 수준 계약
의 시작 날짜 및 종료 날짜에 따라 자동으로 꺼지고 켜집니다. SLM 관리에서 
서비스 수준 계약을 임시로 중지하여 가용성 및 준수 계산을 수동으로 끌 수도 
있습니다. 예를 들면, 이 방법은 서비스 수준 계약 유효 기간 동안 서비스 수준 
목표를 수정해야 할 때 필요할 수 있습니다.
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개요

서비스 수준 매니저 기능
측정 항목 데이터 수집

모든 가용성 및 준수 계산은 외부 모니터링 어플리케이션 또는 서비스 데스크
에서 수집한 분석 데이터에서 수집한 측정 항목 데이터 값을 기반으로 합니다. 
서비스 수준 매니저는 측정 항목 어댑터를 제공하고, 설치 및 구성된 경우에는 
지원되는 모니터링 어플리케이션에서 측정 항목 데이터 값 수집 절차를 관리합
니다.

가용성 및 준수 보고서

서비스 수준 매니저는 서비스 수준 관리 절차와 연관된 특정 역할에 대해 사용
자 지정된 미리 구성된 보고서 세트를 제공합니다.

일부 보고서에는 요약 정보가 있습니다. 다른 보고서는 더 자세한 내용이 있습
니다. 요약 보고서를 생성하거나 온라인으로 확인할 때에는 관심 있는 개별 라
인을 강조하여 자세한 그래픽 정보를 때때로 드릴다운할 수 있습니다. 다른 관
점에서 정보를 보여주는 다른 보고서로 이동할 수 있도록 하이퍼링크가 포함
된 보고서도 있습니다. 

보고서는 평가 기간 동안 요청에 따라 계획되거나 제작될 수 있습니다. 
OpenView 콘솔에 내장된 OVPI 보고서 뷰어를 사용하여 SLM 보고서를 볼 수
도 있습니다. 그림 1-3은 서비스 작업영역에서 사용할 수 있는 보고서를 보여
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서비스 수준 매니저 기능
줍니다. 표시된 예에서, 서비스 세부사항 보고서는 서비스1 서비스에 대한 정
보를 표시하도록 선택됩니다.

그림 1-3 서비스에 대한 보고서 보기

실시간 가용성 및 준수 모니터링

SLM 요원은 OpenView 콘솔에서 준수 및 가용성 계산 결과를 모니터링할 
수 있습니다. 계산은 한 평가 기간에 걸쳐 진행되기 때문에 서비스 수준 계약, 
서비스, 구성 항목의 전반적인 상태는 몇 분 정도의 오차는 있을 수 있지만 
상당히 정확합니다. 

미리 구성된 모니터링 뷰는 특정 SLM 사용자 역할과 고객이 민감하게 여기는 
정보의 기밀 보증을 위해 제작되었습니다.

웹 콘솔 제한

웹 콘솔 내 양식 기능 지원에 제한이 있으므로 가용성 및 준수 모니터링과 같
이 SLM 정보를 확인하는 데에만 웹 콘솔을 사용하는 것이 좋습니다. 서비스 
계층, 준수 SLO 테이블, 서비스의 SOL 테이블 속성과 같이 특화된 사용자 인
터페이스 필드 유형은 사용할 수 없습니다. 웹 콘솔에 대한 자세한 내용은 HP 
OpenView Service Desk Administrator's Guide를 참조하십시오.
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배치 유형
배치 유형
여기에서는 단일식과 분포식이라는 두 가지 SLM 배치 유형을 설명합니다.

단일식 배치

이 배치 유형에서 모든 구성 요소는 단일 서버에 설치됩니다. 그림 1-4는 단일
식 배치의 예를 설명한 것입니다.

그림 1-4 단일식 배치의 예

분포식 배치

이 배치 유형에서 구성 요소는 여러 개의 서버에 분산되어 있습니다. 그림 1-5
는 네 서버에 분포된 배치의 예를 보여주는데, 측정 항목 어댑터마다 하나씩
(각 어댑터는 해당 모니터링 어플리케이션을 실행하는 동일한 시스템에 설치
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개요

배치 유형
되어 있음) 배치되며, 서비스 데스크 관리 서버가 설치된 세 번째 서버(SLM 서
버 절차가 실행 중인 서버), HP OpenView 데이터베이스와 OVPI 보고 서버를 
호스팅하는 네 번째 서버에 배치되어 있습니다.

그림 1-5 분포식 배치의 예
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2 서비스 수준 매니저 역할
2장 31



서비스 수준 매니저 역할
SLM 관리자 계정 및 역할
SLM 관리자 계정 및 역할
서비스 수준 매니저는 다음 관리 작업에 사용해야 할 사용자 지정 사용자 계정
과 역할을 지원합니다.

• 일반 SLM 매개 변수 구성

• 측정 항목 어댑터 구성

• 측정 항목 어댑터 상태 검사

• SLM 보고 구성

• 경보 인시던트 트리거링 구성

• SLM 서버 프로세스 시작 및 중지

SLM 구성 작업에 대한 자세한 내용은 서비스 데스크 온라인 도움말에서 확인
할 수 있습니다.

SLM 관리자 계정

SLMAdministrator 계정은 서비스 데스크 관리 서버를 설치할 때 자동으로 
생성됩니다. SLM 관리자는 이 계정을 사용하여 서비스 수준 매니저를 구성해
야 합니다. 

SLMAdministrator 계정은 기본 암호 slmadmin으로 설치됩니다. 보안 유지
를 위해 기본 암호는 교체하는 것이 좋습니다.

SLMAdministrator 계정은 SLMAdministrator 역할로 지정되어 있습니다. 
이 역할은 설치 과정에서 자동으로 설치됩니다.

SLM 코어 계정

SLMCore 계정은 서비스 데스크 관리 서버를 설치할 때 자동으로 생성됩니다. 
이 계정은 통합 계정이므로 사용자 인터페이스에 액세스할 수는 없습니다. 이 
SLM 코어 계정을 삭제하지 마십시오. 서비스 수준 매니저 작업에서 관리 서버
와 통신할 때 이 계정을 사용해야 합니다. 
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서비스 수준 매니저 역할
서비스 고객
서비스 고객
서비스 고객은 서비스 수준 매니저를 통해 서비스의 현재 가용성을 모니터링
할 수 있습니다.

현재 서비스 가용성 모니터링

고객은 자신이 사용하고 있는 서비스의 가용성을 모니터링할 수 있습니다. 이 
서비스에 액세스하는 데 문제가 있는 경우에는 이 기능으로 문제의 원인을 찾
아낼 수 있습니다. 현재 사용할 수 있는 것으로 서비스가 등록되어 있는데도 고
객이 서비스에 액세스할 수 없는 경우에는 서비스 제공자의 헬프 데스크에 문
의하지 않아도 될 정도의 문제 때문일 수 있습니다. 
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서비스 수준 매니저 역할
서비스 디자이너
서비스 디자이너
서비스 디자이너는 서비스 수준 매니저 기능으로 서비스를 디자인하고 모델
링합니다.

디자인 서비스

디자인 서비스에서 서비스 디자이너는 다음과 같은 활동에 참여할 수 있습니다.

• 서비스 정의 작성

• 서비스 정의 유지 관리

서비스 정의 유지 관리

서비스 디자인 유지 관리에서 서비스 디자이너는 다음과 같은 활동에 참여할 
수 있습니다.

• 기존 서비스 정의 변경 요청에 대해 응답합니다. 일반적으로, 변경 요청은 
서비스 관리자 또는 고객 관계 관리자가 요청합니다.

• 서비스 관리자 또는 고객 관계 관리자의 요청에 따라 CI 측정 항목을 추가
하거나 수정합니다. 

• 서비스 관리자 또는 고객 관계 관리자의 요청에 따라 서비스 수준 목표 임
계치를 추가하거나 수정합니다.

• 사용자 지정 디자인을 위한 기능 디자인 활동에 기술적으로 참여합니다.

모델링 서비스

모델링 서비스에서 서비스 디자이너는 다음과 같은 활동에 참여할 수 있습니다.

• 계층 필터 작성

• 계층 필터를 바탕으로 모니터링된 서비스 작성
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서비스 수준 매니저 역할
서비스 관리자
서비스 관리자
서비스 관리자는 서비스 수준 매니저 기능을 사용하여 표준 모니터링 서비스
와 사용자 지정 모니터링 서비스를 작성합니다.

모니터링 서비스 작성

서비스 관리자는 고객별로 알맞은 모니터링 서비스를 작성합니다. 모니터링 
서비스의 준수를 측정하려면 서비스는 다음 중 한 가지를 기반으로 해야 
합니다. 

• 서비스 디자이너가 개발한 서비스 정의. 

• 필수 구성 항목과 서비스 계층의 하위 서비스를 정의하는 계층 필터.

서비스 관리자는 구성 항목의 계획된 다운타임, 서비스 시간 등과 같이 특정 
고객에 대한 모든 정보를 추가합니다. 서비스 관리자는 고객 관계 관리자와 연
계하여 이 정보의 정확성을 확보할 수도 있습니다.

관리된 서비스 수준 계약으로 서비스 연결

서비스 작성 방식과 상관 없이 서비스 수준 계약으로 연결할 필요가 있으며, 
서비스 수준 계약은 SLM 관리하에 두어야 합니다. 일반적으로 이 작업은 
서비스 관리자 또는 고객 관계 관리자가 실시합니다. 

원본 서비스 정의에서 서비스 분리

고객 관계 관리자가 원본 서비스 정의에 적용할 수 없는 변경을 요청할 때 
필요할 수 있습니다. 
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서비스 수준 매니저 역할
고객 관계 관리자
고객 관계 관리자
고객 관계 관리자는 서비스 수준 매니저 기능을 사용하여 서비스 수준 계약을 
정의하고 서비스 제공자 조직 내에서 고객의 이익을 대변하며 현재 서비스 가
용성을 모니터링합니다.

서비스 수준 계약 정의

고객 관계 관리자는 특정 고객에 관한 서비스 수준 계약의 정의를 돕습니다.

서비스 가용성 및 준수 모니터링

고객 관계 관리자는 특정 고객이 사용한 서비스의 가용성과 준수를 모니터링
합니다. 현재 서비스 가용성 조사 여부를 확인하며 필요에 따라 적절한 부대 
계획이 진행되는지 확인합니다.
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서비스 수준 매니저 역할
서비스 플래너
서비스 플래너
서비스 플래너는 대책의 적절성을 식별하여 목표 대비 평가 결과를 비교하는 
장기 전략적 관점을 세웁니다. 효율성을 잃지 않으면서 전반적인 서비스 제공 
수준을 최적화할 수 있도록 가용 리소스를 분배하는 것이 목표입니다. 

서비스 플래너는 현재 가용성과 준수 상태를 모니터링하지 않으며, 실시간 모
니터링 기능을 활용하지도 않습니다. 대신에 서비스 플래너는 목표와 결과를 
명확하게 비교한 보고서에 초점을 맞춥니다. 
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서비스 수준 매니저 역할
서비스 플래너
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3 측정 항목 데이터 수집
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측정 항목 데이터 수집
측정 항목 데이터란 무엇인가?
측정 항목 데이터란 무엇인가?
서비스 수준 매니저는 특정 HP OpenView 모니터링 어플리케이션을 사용하여 
관리된 서비스 수준 계약과 연결된 서비스의 가용성과 서비스 준수 상태를 측
정합니다. 이러한 모니터링 어플리케이션에서 측정 항목 데이터 값을 주기적
으로 수집하지 않으면 OpenView 콘솔에서 서비스 준수 상태를 모니터링할 수 
없으며 SLM 보고서를 만들 수도 없습니다.

측정 항목 데이터를 수집하려면 서비스 수준 매니저가 측정 항목 어댑터를 제
공해야 합니다. 아래 표에는 함께 사용하도록 디자인된 모니터링 어플리케이
션과 함께 각 측정 항목 어댑터가 기재되어 있습니다.

OVIS 측정 항목 어댑터

OVIS 측정 항목 어댑터를 설치하여 구성하면 설치된 OVIS 데이터베이스에서 
수집한 측정 항목 데이터 값을 기반으로 가용성과 준수 여부를 측정할 수 있습
니다.

OVPM 측정 항목 어댑터

OVPM 측정 항목 어댑터를 설치하여 구성하면 설치된 OpenView 성능 관리자 
서버에서 사용할 수 있는 측정 항목 데이터 값을 기반으로 가용성과 준수 여부
를 측정할 수 있습니다. 

서비스 데스크 측정 항목 어댑터

서비스 데스크 측정 항목 어댑터는 서비스 데스크 관리 서버를 설치할 때 자동
으로 설치 및 구성됩니다. 이 어댑터를 사용하면 서비스 데스크 어플리케이션 
서버로 로그한 분석 데이터 기준에 따라 가용성과 준수를 측정할 수 있습니다.

표 3-1 측정 항목 어댑터

측정 항목 어댑터 HP OpenView 모니터링 어플리케이션

Ovisma 인터넷 서비스

Ovpmma 성능 관리자

Ovsdma 서비스 데스크

Ovsnma 작업 Service Navigator
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측정 항목 데이터 수집
측정 항목 데이터란 무엇인가?
OVSN 측정 항목 어댑터

OVSN 측정 항목 어댑터는 서비스 상태 변경 이벤트에 따라 측정 항목 데이터 
값을 수집하여 게시합니다. Service Navigator 서비스는 구성 항목 또는 서비스
와 일치할 수 있으므로, 이 측정 항목 어댑터를 사용하여 구성 항목의 가용성뿐 
아니라 서비스 준수 여부를 측정할 수 있습니다. 검색 절차는 현재 모니터링 중
인 Service Navigator 서비스를 모두 확인합니다. 초기 검색 절차 결과는 어플리
케이션 서버에 전달된 각 서비스 상태에 나타납니다. 이 때부터 측정 항목 어댑
터는 각 상태 변경 이벤트를 게시합니다. OVSN 측정 항목 정의는 SPI가 생성
한 노드의 사양에 따라 식별됩니다(54페이지의 "OVSN MRP 정의 및 SPI 분석 
구성 파일" 참조). Service Navigator는 전체 및 운영 서비스 상태를 지원합니다. 
OVSN 측정 항목 어댑터가 Service Navigator에서 사용할 수 있는 측정 항목 데
이터를 수신하도록 하려면 전체 상태를 비활성화하지 말고 전체에서 운영으로 
기본 상태를 변경하지 마십시오. 

미해결 측정 항목 어댑터

미해결 측정 항목 어댑터는 지원되는 측정 항목 어댑터를 제외한 모니터링 어
플리케이션에서 측정 항목 데이터 값을 수집할 수 있는 사용자 지정 SLM 측정 
항목 어댑터를 검색하는 툴킷입니다. 자세한 내용은 HP OpenView Service 
Desk 미해결 측정 항목 어댑터 개발자 안내서를 참조하십시오.

측정 항목 데이터 수집 활성화

측정 항목 데이터 값 수집을 활성화하려면 다음과 같이 해야 합니다.

1. 사용하려는 모니터링 어플리케이션을 설치하여 구성합니다. 모니터링 어
플리케이션은 측정 항목 값으로 SLM 서버를 지원하므로 아래 내용을 확
인해야 합니다.

• 서비스 계층의 구성 항목은 계산할 가용성을 활성화하는 방식으로 
측정해야 합니다. 이는 모든 리프 노드 구성 항목에 적용됩니다. 
서비스 계층에서 하위 구성 항목이 없는 구성 항목을 말합니다. 
계층 위쪽 구성 항목은 측정 항목 데이터 값을 기반으로 가용성을 계
산할 필요가 없으며 가용성 전파 규칙에 따라 가용성을 계산할 수 있
습니다. 
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측정 항목 데이터 수집
측정 항목 데이터란 무엇인가?
• 각 서비스는 계산될 준수 상태를 활성화하는 방식으로 측정해야 합
니다. 인프라 가용성 측정 항목만을 기준으로 서비스의 준수 상태를 
계산하려는 경우에는 다른 방식으로 서비스를 측정할 필요가 없습니
다.

2. 사용하려는 설치된 모니터링 어플리케이션마다 필수 측정 항목 어댑터를 
설치하고 구성합니다. 예를 들어, HP OpenView 인터넷 서비스를 모니터
링 어플리케이션으로 사용하려면 OVIS 측정 항목 어댑터를 설치하고 구
성해야 합니다. 측정 항목 어댑터 설치에 대한 자세한 내용은 HP 
OpenView Service Desk 설치 안내서를 참조하십시오. OVSD 측정 항목 어
댑터는 서비스 데스크 관리 서버를 설치할 때 자동으로 설치, 구성됩니다.

3. 서비스 정의 또는 계층 필터를 기준으로 모니터링된 서비스를 작성하고 
기본 인프라를 통해 측정 항목과 목표를 지정합니다.

4. SLM 관리 아래에 모니터링된 서비스를 놓습니다. 측정 항목 어댑터는 관
리된 서비스 수준 계약이 활성화됨과 동시에 측정 항목 데이터 값을 
자동으로 수집하기 시작합니다. (결국, 실제 시작 날짜에 시작된다는 
뜻입니다.)

주 OVIS, OVPM, OVSN 측정 항목 어댑터는 관련 모니터링 어플리케이션을 설치
하고 구성할 때까지 테스트할 수 없습니다. 관련 모니터링 어플리케이션에서 
이러한 측정 항목 어댑터 중 하나의 동작을 모의 시험해 보려면 적절한 측정 
항목 어댑터 시뮬레이터를 사용하십시오(60페이지의 "측정 항목 어댑터 시뮬
레이터" 참조).
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측정 항목 어댑터 구성 파일
측정 항목 어댑터 설치 및 구성에 대한 자세한 내용은 HP OpenView Service 
Desk 설치 안내서를 참조하십시오.

측정 항목 어댑터를 구성한 다음에는 OpenView 콘솔에서 등록했는지 확인해
야 합니다. 

OpenView 콘솔에서 측정 항목 어댑터를 등록했는지 확인하려면 다음과 같
이 수행하십시오.

1. SLM 관리자 계정으로 HP OpenView 콘솔에 로그온합니다.

2. OpenView 콘솔에서 SLM 작업영역 그룹을 엽니다.

3. 측정 항목 어댑터 작업영역을 선택합니다.

측정 항목 어댑터가 목록에 보여야 합니다. 측정 항목 어댑터가 목록에 
표시되지 않는 이유는 다음과 같습니다.

• SLM 서버가 실행되고 있지 않습니다. 

• 측정 항목 어댑터가 실행되고 있지 않습니다.

• 측정 항목 어댑터 구성 파일이 SLM 서버를 제대로 지정하지 않습니
다.

측정 항목 어댑터 구성 설정

구성 설정은 측정 항목 어댑터 구성 파일에 저장됩니다. 릴리즈 노트에 다음과 
같은 특별 지침이 제시되는 경우가 아니라면 구성 파일을 수정하지 않는 것이 
좋습니다. 다음과 같은 범주 중 하나에 각 구성 설정이 속해 있습니다.

• 특정 측정 항목 어댑터의 작동 또는 SLM 서버로의 연결을 지정하는 일반 
설정입니다.

• 커넥터 설정은 측정 항목 어댑터 전용입니다. 데이터베이스 사용자 ID 및 
암호와 같은 모니터링 어플리케이션에 연결하는 데 필요한 정보를 지정합
니다.
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• 검색 및 위치 필터는 측정 항목 어댑터 전용입니다. 측정 항목 검색시 확인
된 측정 항목의 양을 어떻게 줄이는지 지정합니다. (베타 릴리즈에는 이 
기능이 없습니다.)

• 작업 설정은 측정 항목 어댑터 전용입니다. 이 설정은 커넥터에 종속되며, 
측정 참조 포인트를 그룹화하는 방식을 지정하여 측정 항목 값이 함께 수
집되도록 합니다.

• 데이터 포인트 설정은 측정 항목 어댑터 전용입니다. 이 설정은 수집할 각 
측정 항목 데이터를 식별하는 데 필요한 정보를 지정합니다. 

일반 측정 항목 어댑터 구성 설정

특별히 명시된 내용이 없는 한, 다음 구성 설정은 모든 유형의 측정 항목 어댑
터에 적용됩니다.

• DataPointSynchronizationDelay

측정 항목 데이터 값의 보유 지연 기간(최신 전달 값의 타임 스탬프로 
측정).

• DefaultTaskExpirePeriod

작업 구성에서 만료 기간을 지정하지 않았을 때 사용. 이 설정은 측정 
항목 검색에서 작성한 구성에서 사용된 것 중 하나입니다.

• DefaultTaskPollingPeriod

작업 구성에서 폴링 간격을 지정하지 않았을 때 사용. 이 설정은 측정 
항목 검색에서 작성한 구성에서 사용된 것 중 하나입니다.

• DiscoveryInterval

예정된 검색 폴링 간격(초 단위). 예정된 검색을 비활성화하려면 이 값을 0
으로 설정하십시오.

• DiscoveryMaxHistory

OVIS에만 적용되는 검색 시간 필터(분 단위). 지정된 시간보다 오래된 
측정 항목은 시간이 지난 것으로 간주해 무시됩니다. 매개 변수가 24*60으
로 설정되어 있는 경우, 하루 이상 늦은 측정 항목은 무시됩니다.
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• HeartBeatsInterval

하트비트 폴링 간격(초 단위). 하트비트 폴링을 비활성화하려면 이 값을 
0으로 설정하십시오.

• IsEventBased

이벤트 기반 플래그. 데이터 포인트가 이벤트 기반이든 폴링 상태이든 매 
측정 항목 데이터 포인트와 신호를 서버에 게시할 때 사용됩니다. OVIS 
측정 항목 어댑터의 경우 이 값은 "0"입니다(폴링됨).

• MrpDefinitionDiscoveryInterval

예정된 측정 항목 정의 검색 폴링 간격(초 단위). 값이 0(영)이면 예정된 측
정 항목 정의 검색이 비활성화됩니다.

• Publisher.APP_NAME

게시자가 사용하는 저장 및 전달 클라이언트 객체의 어플리케이션 이름.

• Publisher.DESTINATION

데이터 포인트를 보낼 때 게시자가 저장 및 전달 대상으로 사용하는 전체 
URL.

• Publisher.MAX_FILE_BUFFER_SIZE

통신 장애 발생시, 측정 항목 어댑터 게시자에서 SLM 코어로의 저장 및 전
달 연결에 사용되는 최대 디스크 버퍼 크기(KB 단위) 값이 0(영)이면 버퍼 
크기에 제한이 없다는 뜻입니다(디스크 용량까지 사용).

• Publisher.RESPONSE_TIMEOUT

게시자가 사용하는 저장 및 전달 클라이언트 객체의 BBC 응답 시간 초과.

• SequenceNumber

구성 서버로부터 측정 항목 어댑터가 수신한 구성 숫자. 

• ServerHost

SLM 서버 시스템의 이름. 

• TypeByte

원본 유형 플래그. 데이터 포인트를 게시할 때마다 사용. 측정 항목 어댑터
로부터 서버로 데이터가 들어오고 있다는 신호 값(1). 다른 값들은 나중에 
사용할 수 있도록 보존됩니다.
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미해결 MA 구성 설정

다음 구성 설정은 미해결 측정 항목 구성에 특별히 적용됩니다.

미해결 MA 커넥터 구성 설정

• class

커넥터 클래스의 이름(고정됨: 
com.hp.ov.sd.slm.sa.openma.OpenConnector)

미해결 MA 작업 구성 설정

• ConnectorRef

연결된 커넥터의 이름(고정됨: Open Connector)

• PollingPeriod

이 작업의 일정에 대한 폴링 간격. 이 필드가 없는 경우에는 측정 항목 
어댑터의 일반 설정에 지정된 DefaultTaskPollingPeriod 값이 사용됩
니다.

• ExpirePeriod

데이터 포인트 만료 시간(초 단위). 이 필드가 없는 경우에는 측정 항목 
어댑터의 일반 설정에 지정된 DefaultTaskExpirePeriod 값이 사용
됩니다.

미해결 MA 데이터 포인트 구성 설정

• SourceIdentifier

측정 항목을 생성하는 모니터링 어플리케이션의 이름.

• MetricTypeValue1

사용자 지정 측정 항목 정의 속성 1.

• MetricTypeName1

사용자 지정 측정 항목 정의 속성 "측정 항목 유형 값 1"의 표시된 이름.

• MetricTypeValue2

사용자 지정 측정 항목 정의 속성 2.
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• MetricTypeName2

사용자 지정 측정 항목 정의 속성 "측정 항목 유형 값 2"의 표시된 이름.

• MetricTypeValue3

사용자 지정 측정 항목 정의 속성 3.

• MetricTypeName3

사용자 지정 측정 항목 정의 속성 "측정 항목 유형 값 3"의 표시된 이름.

• MetricTypeValue4

사용자 지정 측정 항목 정의 속성 4.

• MetricTypeName4

사용자 지정 측정 항목 정의 속성 "측정 항목 유형 값 4"의 표시된 이름.

• User Data Value 1

사용자 지정 측정 항목 속성 1.

• User Data Name 1

사용자 지정 측정 항목 속성 "사용자 데이터 값 1"의 표시된 이름.

• User Data Value 2

사용자 지정 측정 항목 속성 2.

• User Data Name 2

사용자 지정 측정 항목 속성 "사용자 데이터 값 2"의 표시된 이름.

• User Data Value 3

사용자 지정 측정 항목 속성 3.

• User Data Name 3

사용자 지정 측정 항목 속성 "사용자 데이터 값 3"의 표시된 이름.

• User Data Value 4

사용자 지정 측정 항목 속성 4.

• User Data Name 4

사용자 지정 측정 항목 속성 "사용자 데이터 값 4"의 표시된 이름.
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• User Data Value 5

사용자 지정 측정 항목 속성 5.

• User Data Name 5

사용자 지정 측정 항목 속성 "사용자 데이터 값 5"의 표시된 이름.

• User Data Value 6

사용자 지정 측정 항목 속성 6.

• User Data Name 6

사용자 지정 측정 항목 속성 "사용자 데이터 값 6"의 표시된 이름.

OVIS 구성 설정

다음 구성 설정은 OVIS 측정 항목 구성에 특별히 적용됩니다.

OVIS 커넥터 구성 설정

• URL

JDBC 드라이버의 완전한 URL 연결 문자열.

• Table

OVIS 데이터베이스 테이블(기본값: IOPS_DETAIL_DATA).

• Password

OVIS 데이터베이스 암호.

• Login

OVIS 데이터베이스 로그인 이름.

• DBName

OVIS 데이터베이스의 이름.

• Class

커넥터 클래스의 이름(고정됨: 
com.hp.ov.sd.slm.sa.ovis.Connector)
3장48



측정 항목 데이터 수집
측정 항목 어댑터 구성 파일
• Host

OVIS 설치의 호스트 이름 또는 IP 주소.

• NbReconnection

OVIS 데이터베이스로 시도된 재연결 횟수.

• DriverName

연결에 사용된 JDBC 드라이버 이름.

• Port

OVIS 데이터베이스 인스턴스의 포트 번호.

• Timeout

JDBC 연결 시간 제한(초 단위).

OVIS 작업 구성 설정

• Connector

연결된 커넥터의 이름.

• MaxHistoryLimit

정리 시작 시 첫 번째 요청에 대한 최대 히스토리 간격(초 단위).

• PollingPeriod

이 작업의 일정에 대한 폴링 간격. 이 필드가 없는 경우에는 측정 항목 
어댑터의 일반 설정에 지정된 DefaultTaskPollingPeriod 값이 사용됩
니다.

• ExpirePeriod

데이터 포인트 만료 시간(초 단위). 이 필드가 없는 경우에는 측정 항목 
어댑터의 일반 설정에 지정된 DefaultTaskExpirePeriod 값이 사용
됩니다.

• Table

커넥터 구성 설정에 지정된 테이블 이름을 사용하는 작업의 경우, OVIS 
데이터베이스 테이블 또는 %TABLE%의 이름.
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• Filter

이 작업이 사용한 SQL 쿼리에서 WHERE 명령문의 일부분. 기본적으로, 
PROBENAME에 연결된 데이터만 필터링합니다.

OVIS 데이터 포인트 구성 설정

• Metric

측정 항목 유형을 지정하는 IOPS_DETAIL_DATA 테이블에서 가져온 필드 
이름(예: AVAILABILITY, TRANFERTPUT, RESPONSETIME 또는 
SETUPTIME).

• System

OVIS(즉, OVIS 서버 이름)에서 가져온 SYSTEM 필드 값.

• Host

OVIS(즉, 모니터링된 시스템)에서 가져온 HOST 필드 값.

• Target

OVIS(프로브에 따라 다름)에서 가져온 TARGET 필드 값.

• Probe

프로브 유형.

OVPM 구성 설정

다음 구성 설정은 OVPM 측정 항목 구성에 특별히 적용됩니다.

OVPM 커넥터 구성 설정

• URL

OVPM의 완전한 URL 연결 문자열.

• Password

OVPM 사용자 계정의 암호.

• Login

OVPM 사용자 계정의 로그인 이름.
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• Class

커넥터 클래스의 이름(고정됨: 
com.hp.ov.sd.slm.sa.ovpm.Connector)

• Host

OVPM 설치의 호스트 이름 또는 IP 주소.

• NbReconnection

OVPM 서버로 시도된 재연결 횟수.

• Port

실행 중인 OVPM 인스턴스의 포트 번호.

OVPM 작업 구성 설정

• MonitoredSystem

OVPM에서 구성한 모니터링된 시스템의 이름.

• TimeDiff

시간 차(고정값: 0).

• Connector

연결된 커넥터의 이름.

• MaxHistoryLimit

정리 시작 시 첫 번째 요청에 대한 최대 히스토리 간격(초 단위).

• Filter

연결 구현에 따라 측정 참조 포인트 수집에 적용될 필터.

• PollingPeriod

이 작업의 일정에 대한 폴링 간격. 이 필드가 없는 경우에는 측정 항목 
어댑터의 일반 설정에 지정된 DefaultTaskPollingPeriod 값이 사용됩
니다.
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• ExpirePeriod

데이터 포인트 만료 시간(초 단위). 이 필드가 없는 경우에는 측정 항목 
어댑터의 일반 설정에 지정된 DefaultTaskExpirePeriod 값이 사용
됩니다.

OVPM 데이터 포인트 구성 설정

• Metric

OVPM 측정 항목 이름. 

• OvpmSystem

OVPM에서 구성한 모니터링된 시스템의 이름.

• OvpmServer

OVPM 설치의 호스트 이름 또는 IP 주소.

• OvpmClass

측정 항목이 속할 클래스 이름.

• OvpmFilter

옵션 필터 문자열.

OVSN 구성 설정

다음 구성 설정은 OVSN 측정 항목 구성에 특별히 적용됩니다.

OVSN 커넥터 구성 설정

• Class

커넥터 클래스의 이름(고정됨: 
com.hp.ov.sd.slm.sa.ovsn.Connector)

• Host

OVSN 설치의 호스트 이름 또는 IP 주소.

• NbReconnction

재연결 횟수.
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• Port

실행 중인 OVSN 설치의 포트 번호(기본값 7278).

• Timeout

JDBC 연결 시간 제한(초 단위).

OVSN 작업 구성 설정

• Connector

연결된 커넥터의 이름.

• PollingPeriod

이 작업의 일정에 대한 폴링 간격. OVSN 측정 항목 어댑터는 이벤트 
기반이므로 수신기 구성요소의 상태를 주기적으로 점검하는 데 이 값
을 사용합니다.

OVSN 데이터 포인트 구성 설정

• Metric

OVSN에서 구성한 서비스 이름.

• Host

OVSN 서버 이름.

• Label

노드를 식별하는 텍스트.
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OVSN MRP 정의 및 SPI 분석 구성 파일
여기에서는 OVSN MRP 정의와 OVSN SPI 분석을 위한 구성 파일에 대해 설명
합니다.

OVSN MRP 정의

다른 모니터링 어플리케이션에서 발견한 측정 참조 포인트 정의와 달리, 
OVSN MRP 정의는 OpenView Service Navigator에서 직접 가져온 텍스트 필드
로 특성화되지 않습니다.

OVSN 노드의 서비스 이름은 OVSN MRP 필드 Metric으로도 매핑되어 있습
니다.

노드 및 서비스 이름은 SPI가 자동으로 작성합니다. SPI는 토폴로지를 검색하
며 입력 값과 기술에 따라 여러 하위 노드를 작성합니다.

그런 다음, 텍스트 중 일부가 측정 항목 위치로 식별되고 다른 일부는 측정 항
목 정의로 식별되어야 합니다.

예 1

• Oracle:Listener:139.50.38.157

— Oracle:Listener

— 139.50.38.157

• Oracle:EC:139.50.38.157

— Oracle:EC

— 139.50.38.157

• OVOAgent:139.50.37.185

— OVOAgent

— 139.50.37.185

• SLM

— SLM

—
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예 2

• OSSPI:phydisk@@ovsolt17.india.hp.com

— OSSPI:phydisk

— ovsolt17.india.hp.com

• OSSPI:phydisk:/dev/rdsk/c0t0d0s0@@ovsolt17.india.hp.com

— OSSPI:phydisk:/dev/rdsk/c0t0d0s0

— ovsolt17.india.hp.com

• OSSPI:netif@@ovsolt17.india.hp.com

— OSSPI:netif

— ovsolt17.india.hp.com

• OSSPI:netif:eri0@@ovsolt17.india.hp.com

— OSSPI:netif:eri0

— ovsolt17.india.hp.com

• OSSPI:netif:eri0:net@@ovsolt17.india.hp.com

— OSSPI:netif:eri0:net

— ovsolt17.india.hp.com

예 3

이 이론적 사례는 실제 SPI에 의존한 것이 아닙니다.

• MyFirstKey(somewhere.hp.com)MySecondKey

— MyFirstKeyMySecondKey

— somewhere.hp.com

• MyFirstKey(shortname(.hp.com))MySecondKey

— MyFirstKeyMySecondKey

— Shortname(.hp.com)
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선형 분석

선형 분석은 구분 문자 검색 경계 내에서 왼쪽에서 오른쪽, 오른쪽에서 왼쪽으
로의 커서 이동으로 구성됩니다. 이 간격 안에 있는 텍스트는 정의 또는 위치
로 추출됩니다.

OVSN SPI 분석 구성 파일

OvsnMA_SpiParsing.xml 파일은 OvsnMA.xml 구성 파일과 같은 위치에 있
습니다.

이 구성 파일의 목적은 측정 항목 정의와 측정 항목 위치의 구분 방법을 지정
하는 것입니다.

<!--

Don't forget to replace XML special characters to references. 

Character   Reference

&       &amp;

<       &lt;

>       &gt;

"       &quot;

'       &apos;

-->

<SpiParsingList>

    <!— DEFI:NIT:ION:LOCATION -->

    <SpiLinearParsing>

        <LinearLeftParsing>

            <DefinitionExtraction/>

            <Delimiter extract=”none”>:</Delimiter>

            <LocationExtraction>

        <LinearLeftParsing>

    </SpiLinearParsing>

    <!— DEFINITION@@LOC@@TION -->

    <SpiLinearParsing>
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        <LinearRightParsing>

            <DefinitionExtraction>

            <Delimiter extract=”none”>@@</Delimiter>

            <LocationExtraction>

        </LinearRightParsing>

    </SpiLinearParsing>

    <!— DEF(LOC(A)TION)INITION -->

    <SpiLinearParsing>

        <LinearRightParsing>

            <DefinitionExtraction/>

            <Delimiter extract=”none”>(</Delimiter>

            <LocationExtraction/>

        </LinearRightParsing>

        <LinearLeftParsing>

            <Delimiter extract=”none”>)</Delimiter>

            <DefinitionExtraction/>

        </LinearLeftParsing>

    </SpiLinearParsing>

    <!— “CPU”_LOCATION -->

    <SpiLinearParsing>

        <LinearRightParsing>

            <Delimiter extract=”Definition”>CPU</Delimiter>

            <Delimiter extract=”none”>_</Delimiter>

            <LocationExtraction/>

        </LinearRightParsing>

    </SpiLinearParsing>

    <!— “DISK”_LOCATION -->

    <SpiLinearParsing>

        <LinearRightParsing>

            <Delimiter extract=”Definition”>DISK</Delimiter>
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            <Delimiter extract=”none”>_</Delimiter>

            <LocationExtraction/>

        </LinearRightParsing>

    </SpiLinearParsing>

    …

    …

</SpiParsingList>

OVSN SPI 분석 구성 설정

• SpiParsingList

SPI 분석 결과 목록이 들어 있습니다. 어댑터가 일치된 항목을 찾을 때까
지(즉, 모든 구분 문자를 찾을 때까지) 분석이 각각 실시됩니다.

• SpiLinearParsing

SPI의 분석 사양, 선형 분석 사용.

• LinearRightParsing

왼쪽에서 오른쪽으로 분석. 내부 태그는 왼쪽에서 오른쪽으로 정의됩니다.

• LinearLeftParsing

오른쪽에서 왼쪽으로 분석. 내부 태그는 왼쪽에서 오른쪽으로 정의됩니다.

• DefinitionExtraction

정의로 추출될 부분.

• LocationExtraction

위치로 추출될 부분.

• Delimiter extract=”none”

분석 방향으로 진행할 구분 문자. 발견된 구분 문자는 정의 텍스트 및 
위치 텍스트에서 배제됩니다.
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• Delimiter extract=”Definition”

분석 방향으로 진행할 구분 문자. 발견된 구분 문자는 정의 텍스트에 포함
됩니다. 이 구분 문자는 문자열 일치에도 매우 유용합니다.

• Delimiter extract=”Location”

분석 방향으로 진행할 구분 문자. 발견된 구분 문자는 위치 텍스트에 포함
됩니다. 이 구분 문자는 문자열 일치에도 매우 유용합니다.
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측정 항목 어댑터 시뮬레이터
측정 항목 어댑터 시뮬레이터는 SLM 관리자, 서비스 디자이너, 서비스 관리자
를 활성화하여 관련 모니터링 어플리케이션을 설치하고 구성할 필요 없이 
OVIS, OVPM, OVSN 측정 항목 어댑터의 동작을 모의로 시험합니다.

측정 항목 시뮬레이터는 다음과 같은 동작을 에뮬레이션 처리합니다.

• 측정 항목 검색

• 데이터 포인트 수집 및 SLM 서버로 전달

• 하트비트 폴링(측정 항목 어댑터 시뮬레이터의 가용성 확인)

측정 항목 어댑터 시뮬레이터 구성

1. 60페이지의 "측정 항목 어댑터 구성 파일 정의"

2. 62페이지의 "측정 항목 어댑터 시뮬레이터 입력 파일 작성"

3. 66페이지의 "측정 항목 어댑터 시뮬레이터 시작"

측정 항목 어댑터 구성 파일 정의

측정 항목 어댑터 시뮬레이터가 사용할 구성 파일을 정의해야 합니다.

OvisMA.xml의 구성 파일은 다음과 같습니다.

그림 3-1 OVIS 측정 항목 어댑터 시뮬레이터의 구성 파일

<?xml version="1.0" encoding="UTF-8"?>

<Config>

    <MA name="OvisMA">

        <Publisher.BUFFER_PATH/>

        <Publisher.APP_NAME>OvisMASimulator</Publisher.APP_NAME>

        <ServerHost>localhost</ServerHost>

        <Publisher.MAX_FILE_BUFFER_SIZE/>

        <DefaultTaskPollingPeriod>300</DefaultTaskPollingPeriod>
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        <DataPointVersionByte>1</DataPointVersionByte>

        <DataPointSynchronizationDelay>10</DataPointSynchronizationDelay>

        
<Publisher.BUFFERSIZE_OUTPUT_STREAM>0</Publisher.BUFFERSIZE_OUTPUT_STREAM>

        <TypeByte>1</TypeByte>

        <isEventBased>0</isEventBased>

        <SequenceNumber>0</SequenceNumber>

        <Publisher.RESPONSE_TIMEOUT>60</Publisher.RESPONSE_TIMEOUT>

        <HeartBeatsInterval>300</HeartBeatsInterval>

        <DiscoveryInterval>0</DiscoveryInterval>

        <DefaultTaskExpirePeriod>600</DefaultTaskExpirePeriod>

    </MA>

    <Connector name="input1">

        <Class>com.hp.ov.sd.slm.sa.simulator.Connector</Class>

        <File>OvisMAInput.txt</File>

    </Connector>

    <Task name="Task1">

        <Connector>input1</Connector>

    </Task>

    <DiscoveryLocationFilter>

        <All/>

    </DiscoveryLocationFilter>

    <DiscoveryMrpDefinitionFilter>

        <All/>

    </DiscoveryMrpDefinitionFilter>

</Config>

OVPM 및 OVSN 측정 항목 어댑터 시뮬레이터의 경우에는 문자열 OvisMA를 
다음 위치에서 OvpmMA 또는 OvsnMA로 교체해야 합니다.

<MA name="OvisMA">

        <Publisher.APP_NAME>OvisMASimulator</Publisher.APP_NAME>
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        <File>OvisMAInput.txt</File>

테스트 속도를 높이기 위해 다음 매개 변수의 값을 줄일 수도 있습니다.

• DataPointSynchronizationDelay

• DefaultTaskPollingPeriod

측정 항목 어댑터 시뮬레이터 입력 파일 작성

측정 항목 어댑터 시뮬레이터 입력 파일을 만들어 시뮬레이션 기준을 정의해
야 합니다. 측정 항목 어댑터 시뮬레이션 구성 파일에서 입력 파일을 지정할 
필요가 있습니다(60페이지의 "측정 항목 어댑터 구성 파일 정의"의 구성 파일 
예에서 입력 파일의 이름은 OvisMAInput.txt).

입력 파일은 다음과 같은 정보를 지정합니다.

• 검색할 측정 항목

검색한 측정 항목별로 지정된 이름은 검색한 측정 항목의 일반 명명 규칙을 
따릅니다. 자세한 내용은 서비스 데스크 온라인 도움말을 참조하십시오.

• 주기적 간격마다 SLM 서버로 보낼 데이터 포인트의 탭 구분 목록(즉, 측
정 항목 값)

시뮬레이터는 작업 폴링 기간별 값 목록의 다음 값으로 이를 반복합니다. 
목록 끝 부분에 도달할 때마다 시뮬레이터는 목록 처음으로 돌아갑니다.

측정 항목 어댑터 시뮬레이터 입력 파일을 작성하려면

• 하나의 샘플 입력 파일을 템플릿으로 사용합니다.

샘플 측정 항목 어댑터 시뮬레이터 입력 파일

샘플 OVIS 측정 항목 어댑터 시뮬레이터 입력 파일

#

# The following section defines the Measurement Points

#

<?xml version="1.0" encoding="UTF-8"?>
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<Discovery>

<MRP

name="RESPONSETIME_HTTP_probed.hp.com/_something_probed.hp.com_ovisserver.hp.com

">

<Probe>HTTP</Probe>

<Unit>Seconds</Unit>

<TargetHost>probed.hp.com</TargetHost>

<Metric>RESPONSETIME</Metric>

<TargetInfo>probed.hp.com/</TargetInfo>

<System>ovisserver.hp.com</System>

<Type>Double</Type>

<TaskRef>Task1</TaskRef>

<Customer>someone</Customer>

<ServiceName>something</ServiceName>

<Location>probed.hp.com</Location>

</MRP>

<MRP name="

AVAILABILITY_HTTP_probed.hp.com/_something_probed.hp.com_ovisserver.hp.com">

<Probe>HTTP</Probe>

<Unit>Percent</Unit>

<TargetHost>probed.hp.com</TargetHost>

<Metric>AVAILABILITY</Metric>

<TargetInfo>probed.hp.com/</TargetInfo>

<System>ovisserver.hp.com</System>

<Type>Double</Type>

<TaskRef>Task1</TaskRef>

<Customer>someone</Customer>

<ServiceName>something</ServiceName>

<Location>probed.hp.com</Location>

</MRP>
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</Discovery>

#

# The following section defines the Datapoint values

#

<DataPointValues>

RESPONSETIME_HTTP_probed.hp.com/_something_probed.hp.com_ovisserver.hp.com 1.1

1.2 1.3 1.4

AVAILABILITY_HTTP_probed.hp.com/_something_probed.hp.com_ovisserver.hp.com 1 1 0

1

</DataPointValues>

샘플 OVPM 측정 항목 어댑터 시뮬레이터 입력 파일

# 

# The following section defines the Measurement Points

#

<?xml version="1.0" encoding="UTF-8"?>

<Discovery>

    <MRP name=" 
PROC_MEM_RES_PROC_PROC_NAME=explorer_PROCESS_probed.hp.com+(MWA)_ovpmserver">

        <Type>Integer</Type>

        <TaskRef>Task1</TaskRef>

        <OvpmSystem>probed.hp.com+(MWA)</OvpmSystem>

        <OvpmServer>ovpmserver</OvpmServer>

        <Metric>PROC_MEM_RES</Metric>

        <OvpmClass>PROCESS</OvpmClass>

        <OvpmFilter>PROC_PROC_NAME=explorer</OvpmFilter>

        <Location>probed.hp.com</Location>

    </MRP>

    <MRP name="GBL_CPU_TOTAL_UTIL__GLOBAL_probed.hp.com+(MWA)_ovpmserver">

        <Type>Double</Type>

        <TaskRef>Task1</TaskRef>
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        <OvpmSystem>probed.hp.com+(MWA)</OvpmSystem>

        <OvpmServer>ovpmserver</OvpmServer>

        <Metric>GBL_CPU_TOTAL_UTIL</Metric>

        <OvpmClass>GLOBAL</OvpmClass>

        <OvpmFilter></OvpmFilter>

        <Location>probed.hp.com</Location>

    </MRP>

</Discovery>

# 

# The following section defines the Datapoint values

#

<DataPointValues>

PROC_MEM_RES_PROC_PROC_NAME=explorer_PROCESS_probed.hp.com+(MWA)_ovpmserver 
10000 20000 30000

GBL_CPU_TOTAL_UTIL__GLOBAL_probed.hp.com+(MWA)_ovpmserver10.0 10.5 11.0 11.5

</DataPointValues>

샘플 OVSN 측정 항목 어댑터 시뮬레이터 입력 파일

# 

# The following section defines the Measurement Points

#

<?xml version="1.0" encoding="UTF-8"?>

<Discovery>

    <MRP name="W2K:IISADMIN:probed.hp.com_ovsnserver.hp.com">

        <Type>Integer</Type>

        <TaskRef>Task1</TaskRef>

        <MetricDefinition>W2K:IISADMIN</MetricDefinition>

        <Metric>W2K:IISADMIN:probed.hp.com</Metric>

        <OvsnServer>ovsnserver.hp.com</OvsnServer>

        <Label>W2K:IISADMIN:probed.hp.com label</Label>

        <Location>probed.hp.com</Location>
3장 65



측정 항목 데이터 수집
측정 항목 어댑터 시뮬레이터
    </MRP>

    <MRP name="SAP: probed.hp.com_ovsnserver.hp.com">

        <Type>Integer</Type>

        <TaskRef>Task1</TaskRef>

        <MetricDefinition>SAP</MetricDefinition>

        <Metric>SAP: probed.hp.com</Metric>

        <OvsnServer>ovsnserver.hp.com</OvsnServer>

        <Label>SAP: probed.hp.com_ovsnserver.hp.com label</Label>

        <Location>probed.hp.com</Location>

    </MRP>

</Discovery>

# 

# The following section defines the Datapoint values

#

<DataPointValues>

W2K:IISADMIN:probed.hp.com_ovsnserver.hp.com 1 2 4 8

SAP: probed.hp.com_ovsnserver.hp.com 0 1 2 4

</DataPointValues>

측정 항목 어댑터 시뮬레이터 시작

측정 항목 어댑터 시뮬레이터를 시작하려면 

• 명령 프롬프트에서 사용 중인 운영 체제에 적합한 명령을 실행합니다
(표 3-2 참조).

표 3-2 측정 항목 어댑터 시뮬레이터 시작 명령

운영 체제 스크립트

Windows startMASimulator.bat [OvisMA|OvpmMA|OvsnMA]

HP-UX, 
Solaris

startMASimulator.sh [OvisMA|OvpmMA|OvsnMA]
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예를 들어, Window에서 OVIS 측정 항목 어댑터 시뮬레이터를 시작하려면 명
령 프롬프트에서 다음 명령을 실행하십시오.

startMASimulator.bat OvisMA
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4 가용성 및 준수 계산

이 장에서는 계산 엔진이 모니터링되는 서비스의 가용성과 준수를 어떻게 
계산하는지 설명합니다. 
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가용성 및 준수 계산 개요
서비스 수준 매니저에는 서비스 수신자와 함께 협의한 목표와 비교하여 구성 
항목과 서비스, 서비스 수준 계약의 성과를 측정하는 계산 엔진이 포함되어 있
습니다. 

계산은 다음과 같은 요인을 기반으로 실시됩니다.

• 서비스 계층에서 구성 항목과 서비스에 지정된 각 측정 항목에 대한 사용
자 지정 측정 항목 목표. 

모든 준수 상태 계산은 구성 항목 측정 항목과 서비스 측정 항목의 계산된 
목표 상태를 바탕으로 실시됩니다(71페이지의 "측정 항목 목표 상태" 
참조).

• 사용자 지정 측정 항목 계산 및 가용성 전파 규칙. 

이 규칙들은 얼마나 많은 측정 항목 목표를 달성해야 하며, 얼마나 많은 하
위 서비스와 구성 항목을 사용할 수 있도록 해야 하는지 설명합니다
(77페이지의 "측정 항목 계산 규칙" 및 78페이지의 "가용성 전파 규칙" 
참조).

• 서비스 수신자와 합의한 서비스 시간.

서비스 시간 외에 달성되지 않은 측정 항목 목표는 가용성 및 준수 계산에
서 무시됩니다. 

• 구성 항목에 지정된 계획된 다운타임 스케줄.

계획된 다운타임 기간 동안 달성되지 않은 측정 항목 목표는 가용성 및 준
수 계산에서 무시됩니다. 
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측정 항목 목표 상태
모든 가용성 및 준수 계산은 SLM 요원이 지정한 측정 항목 목표와 계산 엔진
으로 계산한 측정 항목 목표 상태를 기준으로 합니다. 

SLM 요원은 각 구성 항목 측정 항목과 서비스 계층의 서비스 측정 항목마다 
측정 항목 목표를 지정할 수 있습니다. 목표가 있는 측정 항목은 가용성 및 준
수 계산에 포함됩니다. 목표가 없는 측정 항목은 가용성 및 준수 계산에서 무
시되지만 SLM 보고서에는 수집됩니다.

측정 항목 목표는 목표 임계치 값과 연산자의 조합입니다. 이 속성들은 측정 
항목 어댑터가 제공하는 측정 항목 데이터 값을 비교하여 목표를 지정합니
다. 측정 항목 어댑터가 측정 항목 데이터 값을 전달할 때마다 목표 상태 계산
은 이 값을 해당 목표 임계치 값과 비교합니다. 이 비교는 현재 측정 항목 목
표 상태를 나타냅니다. 즉 목표를 달성했는지 달성하지 못했는지 보여주는 
것입니다.

예를 들어, 구성 항목 측정 항목에 대한 측정 항목 데이터 값을 0과 1 사이로 지
정할 수 있으며 측정 항목 목표를 임계치 값 0.5와 목표 조건 보다 큼으로 지정
했다고 가정해 보겠습니다. 측정 항목 어댑터가 측정 항목 데이터 값 0.7을 전
달하면 측정 항목의 목표 상태가 달성된 것입니다. 측정 항목 어댑터가 측정 
항목 데이터 값 0.2를 전달하면 측정 항목의 목표 상태가 달성되지 않은 것입
니다. 

그림 4-1은 특정 측정 항목 목표에 대한 몇 시간 동안의 목표 상태를 보여주는 
간단한 그래프입니다. 사용자가 오후 3:00에 구성 항목 측정 항목을 모니터링
하면 목표 상태는 달성되지 않음으로 표시됩니다. 측정 항목 어댑터가 임계치 
값 이상의 측정 항목 데이터 값을 전달하는 오후 4:00까지는 이 상태가 유지됩
니다. 사용자가 오후 5:00에 구성 항목 측정 항목을 모니터링하면 목표 상태는 
달성됨으로 표시됩니다.
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그림 4-1 측정 항목 목표 상태 예

측정 항목 어댑터가 측정 항목 데이터 값을 전달할 수 없는 경우 목표 상태 계
산은 구성된 추정 목표 상태를 대신 사용합니다. 자세한 내용은 서비스 데스크 
온라인 도움말을 참조하십시오.

주 현재 릴리즈의 경우 측정 항목 데이터가 측정 항목 데이터 값을 전달할 수 없
는 경우 측정 항목 목표 계산은 변경사항이 없는 것으로 추정하여 이전 값을 
사용합니다.

측정 항목 목표를 지정할 때, SLM 요원은 해당 측정 항목 어댑터가 수신하여 
계산 엔진으로 전달하는 측정 항목 데이터 값의 가능한 범위를 고려해야 합니
다. 인터넷 서비스 가용성 프로브(ICMP ping 등)가 OVIS 측정 항목 어댑터로 0 
또는 1의 값을 전달하는 것을 예로 들어 보겠습니다. 적절한 측정 항목 목표에
는 임계치 값 0.5와 > 연산자(즉, 보다 큼), 임계치 값 1과 >= 연산자
(즉 보다 크거나 같음)가 있을 수 있습니다. OVIS 응답 시간 프로브에 적합한 
목표는 인터넷 서비스 대시보드에 표시된 응답 시간 내역을 참조하여 고를 수 
있습니다.

구성 항목 측정 항목의 목표 상태

구성 항목 측정 항목의 목표 상태는 관련 서비스 수준 계약의 현재 평가 기간
에서 구성 항목의 상태를 스냅샷 느낌으로 보여 줍니다. 예를 들어, 그림 4-3은 
현재 달성된 Email Service Paris 서비스 수준 계약의 영향을 받는 Mail Server 
Paris를 측정하는 두 구성 항목 측정 항목의 목표 상태를 보여줍니다.
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그림 4-2 구성 항목 측정 항목의 목표 상태

모든 구성 항목 측정 항목에는 71페이지의 "측정 항목 목표 상태"에 설명한 것
과 같이 계산된 각각의 목표 상태가 있습니다. 
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서비스 측정 항목의 목표 상태

서비스 측정 항목의 목표 상태는 관련 서비스 수준 계약의 현재 평가 기간에서 
상태를 스냅샷 느낌으로 보여 줍니다. 예를 들어, 그림 4-3은 현재 달성한 Web 
Service Berlin에 대한 두 가지 서비스 측정 항목의 목표 상태와 아직 
계산되지 않은 세 번째 서비스 측정 항목을 보여 줍니다.

그림 4-3 서비스 측정 항목의 목표 상태

인프라 가용성 측정 항목을 제외한 모든 서비스 측정 항목에는 71페이지의 "
측정 항목 목표 상태"에 설명한 것과 같이 계산된 목표 상태가 있습니다. 

인프라 가용성 측정 항목이 계산된 목표 상태를 보유하는 방법은 76페이지의 
"서비스 인프라 가용성"에 나와 있습니다. 

서비스 측정 항목의 목표 상태는 서비스 측정 항목의 준수 상태를 계산하기 위
해 현재 평가 기간을 통해 측정됩니다(80페이지의 "서비스 측정 항목의 준수 
상태"를 참조하십시오).
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서비스 수준 매니저는 서비스 계층에서 다음 객체 유형에 대한 가용성 계산을 
수행합니다.

• 구성 항목

가용성은 서비스 계층을 통해 모든 구성 항목에 대해 계산될 수 있습니다. 
구성 항목의 가용성 상태는 구성 항목 작동 여부를 보여 줍니다. 구성 항목
을 사용할 수도 있고 사용할 수 없을 수도 있습니다. 사용할 수 없는 구성 
항목은 조사와 수리를 위해 전문가에게 할당되어야 합니다. 각 구성 항목
의 가용성 상태를 확인하여 전문가들은 구성 항목이 가용성 전파 규칙을 
준수하지 못하는 이유를 이해하거나 서비스가 인프라 가용성 목표를 달성
하지 못하는 이유를 이해할 수 있습니다(75페이지의 "구성 항목 가용성"을 
참조하십시오).

• 서비스

인프라 가용성 측정 항목의 목표 상태가 달성되면 서비스를 사용할 수 있
습니다(76페이지의 "서비스 인프라 가용성"을 참조하십시오).

가용성 계산은 SLM 관리 아래에 있는 활성 서비스 수준 계약과 연관된 객체에 
대해서만 실시됩니다. 객체 값은 특정 서비스 수준에 적용되므로 각 가용성 계
산의 결과는 특정 서비스 수준 계약에 적용됩니다. 주어진 객체 유형의 경우 
최고 수준의 서비스를 연결할 각 활성 서비스 계약에 대한 객체 값이 하나 있
습니다. 예를 들어, 이는 특정 공유 구성 항목을 한 서비스 수준 계약에 대해 사
용할 수 있으며 다른 서비스 수준 계약에 대해 사용할 수 없음을 뜻합니다.

구성 항목 가용성

구성 항목 가용성 계산은 다음과 같은 요인을 고려합니다.

• 구성 항목이 해당 측정 항목 계산 규칙을 현재 준수하는가? (77페이지를 
참조하십시오.) 

• 구성 항목이 해당 측정 항목 전파 규칙을 현재 준수하는가? (78페이지를 
참조하십시오.)
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구성 항목은 현재 두 규칙을 준수하는 경우에 사용할 수 있는 것으로 정의됩니
다. 두 규칙 중 하나를 위반하는 경우에는 사용할 수 없습니다.

그림 4-4 구성 항목 가용성 계산

서비스 계층에 해당 측정 항목 중 하나에 대해 정의된 목표가 없거나 정의된 
측정 항목이 없는 구성 항목이 포함되어 있는 경우에는 측정 항목 계산 규칙이 
무시됩니다. 가용성은 가용성 전파 규칙과 하위 구성 항목의 가용성을 기반으
로 계산됩니다. 

리프 노드 구성 항목(즉 계층 내에 하위 구성 항목이 없는 구성 항목)에는 가용
성 전파 규칙만을 기준으로 계산된 가용성이 있을 수 없습니다. 리프 노드 구성 
항목에는 관련 목표와 함께 지정된 측정 항목이 하나 이상 있어야 합니다. 

서비스 인프라 가용성

인프라 가용성 객체가 달성된 상태에서는 서비스를 사용할 수 있습니다. 서비
스가 해당 가용성 전파 규칙을 현재 준수하고 있는 경우에는 서비스의 인프라 
가용성 목표가 달성됩니다(78페이지 참조).
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측정 항목 계산 규칙

서비스 계층의 각 구성 항목에 측정 항목 계산 규칙을 할당할 수 있습니다. 측
정 항목 계산 규칙은 구성 항목이 달성해야 할 측정 항목 목표 수에 대한 조건
을 부과합니다. 이 규칙이 깨지면 구성 항목은 사용할 수 없는 것으로 간주됩
니다.

다음 표에는 구성 항목에 대해 선택할 수 있는 측정 항목 계산 규칙이 기록되
어 있습니다.

할당할 가장 적절한 규칙은 구성 항목이 수행하는 기능에 따라 차이가 있습니
다.

• 측정 항목 목표가 하나도 달성되지 않은 경우에는 사용할 수 없는 것으로 
간주되어야 할 구성 항목에 모든 측정 항목 목표 달성 규칙을 할당합니
다. 예를 들어, 서비스 디자이너가 다음 웹 서버의 기준을 테스트하는 측정 
항목에 이 규칙을 할당하는 경우 다음과 같은 측정 항목 목표가 달성되지 
않으면 이 규칙이 깨집니다.

— 웹 서버 서비스가 실행 중인가?

— 웹 서버의 파일 시스템에 액세스할 수 있는가?

• 모든 측정 항목 목표가 달성되지 않은 경우에는 사용할 수 없는 것으로만 
간주되어야 할 구성 항목에 적어도 하나의 측정 항목 목표 달성 규칙을 
할당합니다. 예를 들어, 서비스 디자이너가 서버에서 실행 중인 어플리케
이션의 기준을 테스트하는 측정 항목에 이 규칙을 할당하는 경우 다음과 
같은 두 가지 목표가 달성되지 않으면 이 규칙이 깨집니다.

— PC 클라이언트를 통해 어플리케이션이 액세스할 수 있는가?

— 웹 클라이언트를 통해 어플리케이션이 액세스할 수 있는가?

표 4-1 측정 항목 계산 규칙

규칙 설명

모든 측정 항목 

목표 달성

구성 항목의 모든 측정 항목 목표가 반드시 달성되
어야 합니다.

적어도 하나의 측정 

항목 목표 달성

구성 항목의 측정 항목 목표가 하나 이상 달성되어
야 합니다.
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가용성 전파 규칙

서비스 인프라의 각 구성 항목과 서비스에 가용성 전파 규칙을 할당할 수 있습
니다. 가용성 전파 규칙은 사용할 수 있어야 하는 하위 구성 항목 또는 서비스 
수에 대한 조건을 부과합니다. 이 규칙이 깨지면, 구성 항목 또는 서비스는 사
용할 수 없는 것으로 간주됩니다.

표 4-2에는 서비스에 대해 선택할 수 있는 가용성 전파 규칙이 기재되어 있습
니다.

표 4-3에는 구성 항목에 대해 선택할 수 있는 가용성 전파 규칙이 기재되어 있
습니다.

서비스 또는 구성 항목에 할당할 가장 적절한 규칙은 다음과 같은 하위 구성 
항목 또는 서비스가 실시하는 기능에 따라 차이가 있습니다.

• 하위 구성 항목 및 서비스 중 하나를 사용할 수 없는 경우에는 사용할 수 
없는 것으로 간주해야 할 구성 항목 및 서비스에 모든 하위 항목 사용 
가능 규칙을 할당합니다. 

표 4-2 서비스에 대한 가용성 전파 규칙

규칙 설명

모든 하위 항목 

사용 가능

사용된 CI 속성에 의해 연결된 모든 사용된 구성 항
목과 서비스 사용 속성에 의해 연결된 서비스 인프
라는 현재 사용할 수 있어야 합니다.

적어도 하나의 하위 

항목 사용 가능

사용된 CI 속성에 의해 연결된 하나 이상의 사용된 
구성 항목 또는 서비스 사용 속성에 의해 연결된 서
비스 인프라는 현재 사용할 수 있어야 합니다.

표 4-3 구성 항목에 대한 가용성 전파 규칙

규칙 설명

모든 하위 항목 

사용 가능

관련 CI 속성에 의해 연결된 모든 구성 항목을 현재 
사용할 수 있어야 합니다.

적어도 하나의 하위 

항목 사용 가능

관련 CI 속성에 의해 연결된 하나 이상의 구성 항목
을 현재 사용할 수 있어야 합니다.
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• 모든 하위 CI 및 서비스를 사용할 수 없는 경우에는 사용할 수 없는 것으로 
간주해야 할 구성 항목 및 서비스에 적어도 하나의 하위 항목 사용 
가능 규칙을 할당합니다.

그림 4-5는 서비스 계층 맨 위에 있는 서비스의 가용성 전파 규칙이 고려해야 
할 요인을 보여줍니다. 그 요인은 다음과 같습니다.

• 최상단 수준 서비스에서 사용하는 각 구성 항목의 가용성. 사용된 CI 속성
이 사용하는 최상단 수준 서비스와 연결된 구성 항목만 고려됩니다. 
구성 항목 가용성 계산 방법에 대한 설명은 75페이지의 "구성 항목 가용성
"을 참조하십시오.

• 최상단 수준 서비스에서 사용하는 서비스의 인프라 가용성. 사용된 서비
스 속성이 사용하는 최상단 수준 서비스와 연결된 서비스만 고려됩니다. 
사용된 서비스가 두 개 이상의 활성 서비스 수준 계약과 연결된 경우(예를 
들면, 그림 4-5의 SLA2 및 SLA3), 가용성 전파 규칙은 가장 좋지 않은 인프
라 가용성을 사용합니다.

그림 4-5 인프라 가용성 계산
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준수

서비스 수준 매니저는 활성 서비스 수준 계약과 연관된 다음 객체 유형에 
대한 준수 계산을 수행합니다.

• 서비스

서비스에는 연관된 각 활성 서비스 수준 계약에 대해 계산된 준수 상태가 
있습니다(83페이지의 "서비스 준수 상태" 참조).

• 서비스 수준 계약

모든 활성 서비스 수준 계약에 대해 준수 상태가 계산됩니다(84페이지의 "
서비스 수준 계약 준수 상태" 참조).

서비스 측정 항목의 준수 상태

평가 기간 동안 활성 서비스 수준 계약과 연관된 각 서비스 측정 항목에는 
계산된 준수 상태가 있습니다. 이러한 측정은 서비스 및 서비스 수준 계약이 
준수 상태인지 결정합니다.

준수 상태 계산 방식은 서비스 측정 항목의 측정 항목 범주에 따라 차이가 
있습니다.

• 표준 및 인프라 측정 항목은 준수 퍼센트를 계산할 수 있도록 시간에 따라 
집계되어야 합니다. 그런 다음 준수 퍼센트는 준수 상태를 계산할 수 있도
록 준수 임계치와 비교됩니다(80페이지의 "표준 및 인프라 서비스 측정 항
목의 준수 상태" 참조).

• 집계된 측정 항목은 측정 항목 어댑터가 측정 항목 데이터 값을 계산 엔진
으로 전달할 때 이미 집계됩니다. 이 값은 준수 상태를 계산할 수 있도록 
각각의 측정 항목 목표와 비교됩니다.

표준 및 인프라 서비스 측정 항목의 준수 상태

준수 계산은 서비스 시간 동안 서비스 측정 항목의 목표 상태가 달성되지 않을 
때 기간을 추가합니다. 이 값(총 위반 시간)은 총 서비스 시간(즉, 현재 평가 기
간 동안 예정된 서비스 시간의 총 기간)에서 차감되며 총 서비스 시간으로 나
누어집니다. 이 계산의 결과는 서비스 측정 항목의 준수 퍼센트입니다
(그림 4-6 참조). 
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총 서비스 시간은 고정되어 있으며 위반 시간은 현재 평가 기간을 통해서만 높
일 수 있으므로 준수 퍼센트는 평가 기간 동안 높일 수 없습니다.

그림 4-6 준수 퍼센트 계산 방정식

준수 퍼센트는 준수 위반 임계치 값(지정된 경우)을 비교하여 준수 상태
(즉, 서비스 측정 항목이 준수인지 위반됨인지)를 결정합니다.

그림 4-7의 서비스 측정 항목 상태 양식은 OVIS Responsetime HTTP 서비스 측
정 항목에 대한 준수 퍼센트 계산 예를 보여줍니다. 이 예에서 연관된 
서비스 수준 계약은 월간 평가 기간을 따르며 서비스 시간 예정이 없습니다. 
즉, 서비스 시간이 30일, 720시간의 총 서비스 시간 동안 계속된다는 뜻입니다
. 총 위반 시간은 3시간 20분이며 준수 퍼센트는 ((720-3.333)/720)*100 = 
99.54%로 계산됩니다.

그림 4-7 준수 퍼센트 계산 예

준수 위험 임계치를 지정하는 경우 준수 계산은 준수 퍼센트와 위험 임계치 값
뿐 아니라 위반 임계치 값을 비교하여 준수 상태가 준수, 위험 또는 위반됨 중 
무엇인지 결정합니다. 준수 위험 임계치를 지정하여 서비스 수준 매니저는 준
수 상태가 준수에서 위반됨으로 바뀌기 전에 준수 퍼센트가 위반 임계치까지 
떨어지지 않도록 경고할 수 있습니다. 위험 임계치는 세 가지 값으로 지정할 
수 있으며 심각도 코드는 서로 다릅니다.

Compliance Percentage Total Service Time Violation Time–( )
Total Service Time

---------------------------------------------------------------------------------------------------------- 100×=
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그림 4-8은 목표가 달성되지 않았을 때 목표의 준수 상태가 기간의 결과에 
어떻게 떨어지는지의 예를 보여줍니다.

그림 4-8 표준 및 인프라 서비스 측정 항목의 준수 상태

표준 및 인프라 서비스 측정 항목의 예측 준수 상태

준수 계산은 현재 추세가 남은 평가 기간에 지속될 것으로 가정하여 현재 
측정 기간이 끝날 때 적용될 서비스 측정 항목의 준수 상태를 예측합니다.
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그림 4-9는 예측 준수 퍼센트 계산에 사용될 공식을 보여줍니다. 이는 평가 기
간의 총 서비스 시간 수 대신 현재 평가 기간까지 만료된 서비스 시간을 사용
하는 준수 퍼센트 계산과 다릅니다.

그림 4-9 예측 준수 퍼센트 계산 방정식

예측 준수 퍼센트는 준수 위반 및 위험 임계치 값을 비교하여 예측 준수 상태
를 결정합니다. 예측 준수 상태란 서비스 측정 항목을 준수, 위험, 위반됨 중 하
나로 예측하는 것입니다.

집계된 서비스 측정 항목의 준수 상태

집계된 서비스 측정 항목의 경우 준수 상태는 현재 평가 기간에 대한 최종 측
정 항목 수집이 실행될 때까지 계산되지 않습니다. 계산 기간 끝 부분에 계산 
엔진은 준수 임계치 값과 목표 조건에 대한 최종 측정 항목 수집 결과 값을 비
교합니다. 

집계된 서비스 측정 항목의 예측 준수 상태

준수 계산은 집계된 서비스 측정 항목의 준수 상태를 예측합니다. 이 값은 최
신 측정 항목 수집 결과를 기준으로 현재 평가 기간의 끝 부분에 적용할 수 있
으며, 이어지는 개별 측정 항목 수집이 남은 평가 기간 동안 동일한 결과를 전
달할 것으로 가정합니다.

서비스 준수 상태

준수 계산은 서비스 준수의 다음과 같은 측면을 측정합니다.

• 준수 상태

• 예측 준수 상태

Predicted Compliance Percentage Expired Service Time Violation Time–( )
Expired Service Time

--------------------------------------------------------------------------------------------------------------- 100×=
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서비스 준수 상태

서비스 준수 상태는 해당 서비스 측정 항목의 최저 준수 상태로 정의됩니다. 
예를 들어, 각 서비스 측정 항목의 준수 상태가 위험이면 서비스 준수 상태도 
위험입니다. 서비스 측정 항목 준수 상태가 위반됨으로 변경되면 서비스 준수 
상태도 위반됨으로 변경됩니다.

예측 서비스 준수 상태

예측 서비스 준수 상태는 해당 서비스 측정 항목의 최저 예측 준수 상태로 
정의됩니다. 예를 들어, 평가 기간 끝 부분에 각 서비스 측정 항목의 준수 
상태가 준수로 예측되면, 서비스도 같은 준수 상태를 달성할 것으로 예측
됩니다. 서비스 측정 항목의 예측 준수 퍼센트가 더 낮은 값으로 내려가면
(예: 위험) 예측 서비스 준수 상태도 그 값으로 내려갑니다. 그림 4-10을 
참조하십시오. 

그림 4-10 예측 서비스 준수 상태 예

서비스 수준 계약 준수 상태

준수 계산은 서비스 수준 계약 준수의 다음과 같은 측면을 측정합니다.

• 준수 상태

• 예측 준수 상태
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준수
준수 상태

서비스 수준 계약의 준수 상태는 서비스 수준 계약과 관련된 서비스의 최저 준
수 상태로 정의됩니다. 예를 들어, 모든 서비스가 현재 준수인 경우 서비스 수
준 계약도 현재 준수입니다. 서비스가 더 낮은 준수 상태(예: 위험)로 내려가면
, 서비스 수준 계약도 이 준수 상태로 내려갑니다.

예측 준수 상태

서비스 수준 계약의 예측 준수 상태는 서비스 수준 계약과 관련된 서비스의 최
저 예측 준수 상태로 정의됩니다. 예를 들어, 모든 서비스가 준수로 예측될 경
우 서비스 수준 계약도 준수로 예측됩니다. 서비스가 더 낮은 예측 준수 상태(
예: 위험)로 내려가면, 서비스 수준 계약도 이 예측 상태로 내려갑니다.
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준수
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5 가용성 및 준수 모니터링

이 장에서는 SLM 요원이 관리된 서비스 수준 계약에 따라 서비스 준수 상태를 
어떻게 모니터링하는지 설명합니다.
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가용성 및 준수 모니터링
모니터링 뷰 액세스
모니터링 뷰 액세스
사용자는 표준 뷰와 양식을 사용하여 가용성과 준수를 모니터링할 수 있습니다. 

고객 관계 관리자

고객 관계 관리자는 자신이 담당하는 고객을 위한 서비스를 표시하기 위해 필
터링된 서비스 상태 뷰에 액세스할 수 있어야 합니다. 뷰에는 다음과 같은 속성
이 있어야 합니다.

• 현재 가용성

• 준수 퍼센트

• 준수 상태

• 예측 준수 퍼센트

• 예측 준수 상태

또한 탐색기 형식의 뷰를 사용할 수 있습니다. 이 뷰에는 이전과 같은 필터를 
적용한 탐색 창이 있으며 선택한 서비스의 서비스 측정 항목 목록을 표시하는 
테이블 뷰도 있습니다.

서비스 관리자

서비스 관리자는 자신이 담당하는 서비스를 표시하기 위해 필터링된 서비스 
상태 뷰에 액세스할 수 있어야 합니다. 뷰에는 다음과 같은 속성이 있어야 합
니다.

• 현재 인프라 가용성

• 준수 퍼센트

• 준수 상태

• 예측 준수 퍼센트

• 예측 준수 상태

또한 탐색기 형식의 뷰를 사용할 수 있습니다. 이 뷰에는 이전과 같은 필터를 
적용한 탐색 창이 있으며 선택한 서비스의 서비스 측정 항목 목록을 표시하는 
테이블 뷰도 있습니다.
5장88



가용성 및 준수 모니터링
서비스 인프라 가용성 조사
서비스 인프라 가용성 조사
인프라 가용성은 인프라 가용성 서비스 측정 항목으로 측정할 수 있습니다. 서
비스 인프라를 측정할 수 없는 경우에는 이 서비스가 가용성 전파 규칙을 준수
하지 않고 있다는 뜻입니다. 이는 하나 이상의 하위 서비스 또는 사용된 구성 
항목의 가용성에 번갈아 문제가 발생하기 때문에 나타납니다. 일정 시간 동안 
서비스를 사용할 수 없게 되면 다음과 같은 결과가 발생합니다. 

• 서비스 수신자가 서비스를 사용할 수 없음

• 인프라 가용성 측정 항목이 위험 또는 위반 상태에 빠질 수 있음

서비스를 사용할 수 없는 이유를 조사하려면 각 하위 서비스와 서비스 계층 내 
각 구성 항목의 현재 가용성을 점검해야 합니다(90페이지의 "구성 항목의 가
용성 상태 조사" 참조).
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구성 항목의 가용성 상태 조사
구성 항목의 가용성 상태 조사
구성 항목을 사용할 수 없는 것은 현재 다음 중 하나를 준수하지 않는다는 
뜻입니다. 

• 구성 항목의 가용성 전파 규칙

• 구성 항목의 측정 항목 계산 규칙

가용성에 어떤 문제가 있는지 추적하려면 다음과 같이 수행하십시오.

각 구성 항목 측정 항목의 목표 상태를 먼저 확인합니다. 

• 모든 목표가 달성되고, 구성 항목이 해당 측정 항목 계산 규칙을 준수하는 
경우 현재 가용성 문제는 하위 구성 항목의 가용성 문제 때문에 나타납니
다. 

• 모든 목표가 달성되지 않은 경우에는 구성 항목이 해당 측정 항목 계산 규
칙을 준수하지 못합니다. 측정 항목 계산 규칙이 적어도 하나의 측정 항
목 목표 달성으로 설정되어 있는 경우에는 적어도 하나 이상의 측정 항
목 목표를 달성할 수 있는 액션을 실시해야 합니다. 측정 항목 계산 규칙
이 모든 측정 항목 목표 달성으로 설정되어 있는 경우에는 모든 측정 항
목 목표를 달성할 수 있는 액션을 실시해야 합니다.

• 일부 목표가 달성되지 않았으며 측정 항목 계산 규칙이 적어도 하나의 
측정 항목 목표 달성으로 설정되어 있는 경우에는 구성 항목이 해당 
측정 항목 계산 규칙을 준수하므로 별도의 액션이 필요하지 않습니다. 일
부 목표가 달성되지 않았으며 측정 항목 계산 규칙이 모든 측정 항목 목
표 달성으로 설정되어 있는 경우에는 구성 항목이 해당 측정 항목 계산 
규칙을 준수하지 못하며, 모든 측정 항목 목표를 달성할 수 있는 액션을 
실시해야 합니다.
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서비스 준수 상태 조사
서비스 준수 상태 조사
서비스 준수 상태 중 하나가 위험에 빠지면 준수 목표 중 하나 이상의 준수 
상태가 위험에 빠지게 됩니다. 서비스 측정 항목의 준수 상태를 먼저 점검하십
시오. 

모든 서비스 측정 항목이 준수 상태인 경우에는 인프라 가용성 측정 항목의 준
수 상태를 점검합니다. 상태가 위험에 빠진 경우에는 각 하위 서비스와 
서비스 계층 내 각 구성 항목의 현재 가용성 상태를 조사해야 합니다. 
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서비스 준수 상태 조사
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SLM 보고
OpenView 콘솔에서 보고서 보기
OpenView 콘솔에서 보고서 보기
OpenView 콘솔에 내장된 OVPI 보고서 뷰어를 사용하여 SLM 보고서를 
볼 수 있습니다. 이렇게 하면 상황에 맞는 정보가 보고서에 표시됩니다. 

SLM 보고서를 보려면

1. OpenView 콘솔에서 다음 작업영역 중 하나를 찾습니다.

• 서비스

• 서비스 수준 계약

• 구성 항목

2. 다음 중 하나를 수행하십시오.

• 뷰에 표시된 객체를 선택한 후, 액션 메뉴에서 보고서 하나를 선택
합니다.

• 뷰에 표시된 객체를 마우스 오른쪽 버튼으로 클릭한 후 드롭다운 
메뉴에서 보고서 하나를 선택하십시오.

보고서가 새 창에서 열리고 선택한 객체에 대한 정보를 표시합니다. 
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SLM 보고
보고서에 사용자 액세스 구성
보고서에 사용자 액세스 구성
여기에서는 SLM 보고서 관리자가 SLM 보고서로의 사용자 액세스를 어떻게 
제어하는지 설명합니다.

SLM 데이터 웨어하우스 모델

사용자 차원은 서비스 수준 계약과 서비스에 모두 연관된 사용자를 정의합니다.

• 다음 사용자들은 서비스 수준 계약과 연관이 있습니다.

— 지불 개체(고객 비즈니스 관리자)

— 고객 관계 관리자

• 다음 사용자는 서비스와 연관이 있습니다.

— 서비스 관리자(Service Manager)

— 서비스 관리자(Service Administrator)

사용자 테이블은 "reportingConfigTool"로 채워집니다. 서비스 수준 계약 및 서
비스와 사용자가 어떻게 관련되어 있는지 정의하는 매핑 규칙은 
[dw.configSrv.users] 섹션에 있는 XPL 구성에 저장되어 있으며 사용자 지정할 
수 있습니다. 

서비스에 대해 현재 제공되는 기본값 매핑이 없습니다. 서비스 수준 계약에 대
한 기본 매핑 규칙은 다음과 같습니다.

• PayingEntity=Contract.Paid by Person 

이 매핑은 서비스 수준 계약과 연관된 계약의 지급한 요원 속성이 서비스 
수준 계약에 대한 지불 개체를 나타낸다는 뜻입니다.

• customerRelationshipManager=Contract.To person 

이 매핑은 서비스 수준 계약과 연관된 계약의 요원에게 속성이 서비스 
수준 계약에 대한 고객 RelationshipManager를 나타낸다는 뜻입니다.
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SLM 보고
보고서에 사용자 액세스 구성
OpenView 콘솔에서 보고서로 사용자 액세스

OpenView 콘솔에서 보고서로 사용자가 액세스할 때 다음 항목을 제어할 수 있
습니다.

• 96페이지의 "사용자 역할을 기반으로 하는 액세스 가능한 보고서 필터링"

• 97페이지의 "사용자 기반 보고서 데이터 필터링"

사용자 역할을 기반으로 하는 액세스 가능한 보고서 필터링

내장된 보고서 뷰어를 사용하면 OpenView 콘솔(94페이지의 "OpenView 콘솔
에서 보고서 보기" 참조)에서 직접 보고서를 열 수 있습니다.

이러한 방법으로 사용자가 액세스할 수 있는 보고서는 사용자의 역할
(즉 현재 OpenView 콘솔에 로그온한 사용자의 역할)에 따라 구성될 수 
있습니다. 일반적으로 지불 개체는 SLA 개요, SLA 세부사항, SLO 개요 등 계
약 기반 보고서에 대한 액세스 권한을 부여 받아야 하며 서비스 관리자는 서비
스 개요, 서비스 세부사항, CI 세부사항 등 인프라 보고서에 대한 액세스 권한
을 부여 받아야 합니다.

각 객체 유형(서비스 수준 계약, 서비스 및 구성 항목)에 액세스할 수 있는 
보고서 목록과 역할의 연결은 OpenView 콘솔에서 관리하는 OVPI 보고서 
객체에 의해 정의됩니다.

연결은 다음을 지정하는 일련의 매개 변수 및 값 세트로 구성됩니다.

• 보고서 ID 및 매개 변수.

• 객체 유형.

• 보고서에 액세스할 수 있는 사용자 역할 목록.

• 보고서를 시작하는 시스템 액션의 이름. 이는 사용자가 연관된 객체 유형
의 작업영역을 탐색하고 액션 메뉴에 액세스할 때 사용자에게 표시되는 
명령의 이름입니다.
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보고서에 사용자 액세스 구성
사용자 기반 보고서 데이터 필터링

OpenView 콘솔에서 표시되는 SLM 보고서에 표시된 데이터는 현재 OpenView 
콘솔로 로그온한 사용자에 따라 필터링될 수 있습니다. 일반적으로는 지불 개
체와 연관된 서비스 수준 계약만 SLA 개요 보고서에 기재되어야 합니다.

보고서에 포함된 데이터 필터링은 보고서를 시작할 때 매개 변수를 지정하여 
실시합니다. 현재 사전 구성된 SLM 보고서에는 두 가지 매개 변수가 지원됩니
다.

• 대상 개체 OID(예: SLA 세부사항 보고서에 포함되는 서비스 수준 계약 
OID)

• 사용자 OID(예: SLA 개요 보고서의 지급 개체 OID 또는 서비스 개요 
보고서의 서비스 관리자 OID)

보고서를 시작할 때 적절한 매개 변수 및 값을 인수로 전달하면 매개 변수 
값에 따라 보고서 내용이 필터링됩니다. 지정된 값이 없으면 필터링이 실시
되지 않습니다.

예를 들면 다음과 같습니다.

• SLA 세부사항 보고서를 시작할 때 서비스 수준 계약 OID 매개 변수가 지
정된 경우에는 지정된 서비스 수준 계약과 연관된 정보만 보고서에 
표시됩니다. 이 매개 변수에 지정된 값이 없는 경우에는 모든 서비스 수준 
계약과 연관된 세부사항이 보고서에 포함됩니다.

• SLA 개요 보고서를 시작할 때 사용자 OID 매개 변수가 지정된 경우에는 
지정된 사용자가 지불 개체인 지정된 서비스 수준 계약과 연관된 정보만 
보고서에 포함됩니다. 이 매개 변수에 지정된 값이 없는 경우에는 모든 
서비스 수준 계약이 보고서에 포함됩니다.

내장된 뷰어 보고서 매핑

여기에서는 OpenView 콘솔에서 액세스할 수 있는 SLM 보고서 뷰어의 보고서 
매핑에 필요한 OVPI 보고서 객체의 속성을 설명합니다. 속성 값은 관리자가 
사용자 지정하고 확장할 수 있습니다.

특정 객체 유형의 작업영역 컨텍스트에서 보고서를 시작하는 각 시스템 액션
은 SLM:CI 세부사항과 같은 이름으로 특정 OVPI 보고서 객체에 지정됩니다. 
이 예에서, 보고서는 가용성 및 준수 계산과 관련된 구성 항목의 세부사항을 
나타냅니다.
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OVPI 보고서 객체에는 보고서 시작, 사용자 역할, 보고서 대상 개체 사이의 매
핑을 정의하는 매개 변수 세트가 포함되어 있습니다.

표 6-1은 해당 OVPI 보고서 객체의 구조에 대해 설명합니다.

표 6-1 OVPI 보고서 속성

파일 이름 보고서 이름(OVPI에 정의된 대로)

디렉토리 보고서 경로(OVPI에 정의된 대로)

액션 이름 액션 메뉴에 나타나는 보고서 시작 명령

이름 보고서 창 제목에 나타나는 보고서 이름

대상 개체 액션 메뉴에 명령을 추가하려는 객체 유형

역할 보고서를 시작하도록 허용된 역할 목록.

주: 이 매개 변수가 지정되지 않으면 역할에 관
계없이 모든 사용자가 보고서에 액세스할 수 있
습니다.

매개 변수 보고서 시작 시 보고 시스템으로 전달될 OVPI 
보고서 매개 변수.

OVPI_REPORT_PARAM=[%u|%e]

%u : 콘솔에 로그온한 사용자의 OID

%e : 선택한 객체의 OID
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매핑 예

여기에는 OpenView 콘솔에서 SLM 보고서로의 액세스를 어떻게 제어하는지 
나타내는 내장된 뷰어 보고서 설정 예가 있습니다.

• 시스템 관리자는 SLA 개요 보고서를 열 수 있으며 다음과 같은 서비스 
수준 계약을 모두 볼 수 있습니다.

그림 6-1 시스템 관리자에 대한 SLA 개요 보고서
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• 고객 비즈니스 관리자는 SLA 개요 보고서를 열 수 있으며 연관된 서비스 
수준 계약을 모두 볼 수 있습니다.

그림 6-2 지불 개체에 대한 SLA 개요 보고서
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• 시스템 관리자 및 고객 비즈니스 관리자는 SLA 세부사항 보고서를 열 수 
있으며 선택된 서비스 수준 액정의 세부사항을 볼 수 있습니다.

그림 6-3 시스템 관리자 및 지불 개체에 대한 SLA 세부사항 보고서
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관리 양식 및 보고서
SLM 관리 양식을 사용하면 특정 SLM 보고서 팩 매개 변수를 관리자가 
사용자 지정할 수 있습니다. 표 6-2에는 양식 및 목적이 기재되어 있습니다.

SLM 관리 양식에 액세스하려면

1. OVPI 서버에 설치된 piadmin 도구에서 객체 폴더를 확장합니다.

2. 일반 작업을 엽니다.

필요한 SLM 관리 양식을 선택합니다.

표 6-2 SLM 관리 양식

양식 목적

평가 기간 데이터 에이징 
(SLM_EvalPeriodAging.frep)

SLA 평가 기간에 대한 데이터 에이징 설
정

타임 시프트 데이터 에이징 
(SLM_TimeShiftAging.srep)

타임 시프트에 대한 데이터 에이징 설정
(서비스 시간 및 CI의 계획된 다운타임)

로깅 수준 
(SLM_LoggingLevel.srep)

SLM 보고서 팩 로깅 절차에 대한 로깅 
수준 설정
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평가 기간 데이터 에이징

이 양식을 사용하여 삭제 전에 유지될 특정 평가 기간에 대한 정보 일수를 
지정합니다. 기본 에이징 기간은 1년입니다.

그림 6-4 평가 기간 에이징 양식

타임 시프트 데이터 에이징

이 양식을 사용하여 삭제 전에 유지될 타임 시프트 정보 일수를 지정합니다. 
기본 에이징 기간은 3개월입니다.

그림 6-5 서비스 시간 및 CI 계획된 다운타임 에이징 양식
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로깅 수준

이 양식을 사용하여 데이터를 가져올 때 호출되는 SLM 보고서 팩 로깅 절차에 
대한 로깅 수준을 지정합니다.

그림 6-6 로깅 수준 양식

SLM 구성 및 로깅 보고서에서 가져오기 로그를 볼 수 있습니다. 
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SLM 구성 및 로깅 보고서

SLM 구성 및 로깅 보고서는 성능 파악 표준 뷰어 또는 웹 액세스 서버에 있는 
SLM 보고서/관리자 폴더에서 사용할 수 있습니다. 여기에는 현재 로깅 수준 
및 가장 최근 보고서 팩 로그 개체가 표시됩니다. 

그림 6-7 SLM 구성 및 로깅 보고서
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미리 구성된 SLM 보고서
다음과 같이 미리 구성된 SLM 보고서를 사용할 수 있습니다.

• 고객 비즈니스 관리자 보고서

— 106페이지의 "고객 비즈니스 관리자에 대한 SLA 개요"

— 110페이지의 "고객 비즈니스 관리자에 대한 SLA 세부사항"

— 113페이지의 "고객 비즈니스 관리자에 대한 서비스 세부사항"

— 116페이지의 "고객 비즈니스 관리자에 대한 SLO 세부사항"

• 고객 관계 관리자 보고서

— 120페이지의 "고객 관계 관리자에 대한 SLA 개요"

— 123페이지의 "고객 관계 관리자에 대한 SLA 세부사항"

— 126페이지의 "고객 관계 관리자에 대한 서비스 세부사항"

— 130페이지의 "고객 관계 관리자에 대한 SLO 세부사항"

• 서비스 관리자 보고서

— 134페이지의 "서비스 관리자에 대한 서비스 개요"

— 137페이지의 "서비스 관리자에 대한 서비스 세부사항"

— 140페이지의 "서비스 관리자에 대한 구성 항목 세부사항"

주 현재 릴리즈에서는 OVPI에서 표준 스케줄링 메커니즘을 사용하여 보고서를 
예약합니다. OVPI에서 주문식으로 스케줄링 보고서와 보고서를 작성하는 
방법은 OVPI 설명서를 참조하십시오.

고객 비즈니스 관리자에 대한 SLA 개요

이 보고서는 특정 보고 간격으로 대상 사용자에게 연관된 서비스 수준 계약에 
대한 모든 개요 정보를 제공합니다.
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보고서 스케줄

• 주문식

• 예약됨(매일, 매주 또는 매월), 사용자에 의해 구성됨

보고서 필드

표 6-3 고객 비즈니스 관리자 보고서 필드에 대한 SLA 개요

필드 설명

활성 SLA 목록

SLA 고객 비즈니스 관리자(지정된 경우) 또는 모든 
서비스 수준 계약(고객 비즈니스 관리자가 지정
되지 않은 경우)과 연관된 서비스 수준 계약 목록. 고
객 비즈니스 관리자에 대한 SLA 세부사항 보고서에 
연결하려는 서비스 수준 계약을 클릭합니다.

CRM 서비스 수준 계약과 연관된 고객 관계 관리자

서비스 수준 서비스 수준 계약에 대한 서비스 수준

현재 상태 현재 평가 기간에 대한 서비스 수준 계약의 
준수 상태(준수 또는 위반)

드릴다운 특정 서비스 수준 계약에 대한 개요 정보를 
표시하려면 드릴다운 버튼을 클릭합니다.

평가 기간

평가 기간
(선택 상자)

드릴다운된 서비스 수준 계약에 대한 평가 기간

현재 기간에 대한 SLA 요약

시작 날짜 선택한 평가 기간의 시작 날짜

종료 날짜 선택한 평가 기간의 종료 날짜

최신 상태 선택한 평가 기간에 대한 최신 준수 상태
(준수 또는 위반)
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최신 상태 날짜 최신 준수 상태가 계산된 날짜

서비스 및 서비스 수준 목표

서비스 서비스 수준 계약과 연관된 서비스

준수 SLO 서비스와 연관된 서비스 측정 항목

달성된 준수 선택한 평가 기간에 대해 서비스 측정 항목이 
달성한 준수 값

준수 목표 서비스 측정 항목에 대한 준수 위반 임계치 값

준수 상태 선택한 평가 기간에 대한 서비스 측정 항목의 
준수 상태(준수 또는 위반)

표 6-3 고객 비즈니스 관리자 보고서 필드에 대한 SLA 개요

필드 설명
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그림 6-8 고객 비즈니스 관리자 샘플 보고서에 대한 SLA 개요
6장 109



SLM 보고
미리 구성된 SLM 보고서
고객 비즈니스 관리자에 대한 SLA 세부사항

이 보고서는 특정 보고 간격 동안 특정 서비스 수준 계약에 대한 준수 상태 
세부사항을 보여줍니다.

보고서 스케줄

• 주문식

• 예약됨(매일, 매주 또는 매월), 사용자에 의해 구성됨

보고서 필드

표 6-4 고객 비즈니스 관리자 보고서 필드에 대한 SLA 세부사항

필드 설명

활성 SLA 목록

SLA 고객 관계 관리자(지정된 경우) 또는 모든 서비스 
수준 계약(고객 관계 관리자가 지정되지 않은 경우)
과 연관된 서비스 수준 계약 목록. 고객 비즈니스 관
리자에 대한 SLO 세부사항 보고서에 연결하려는 서
비스 수준 계약을 클릭합니다.

CRM 서비스 수준 계약과 연관된 고객 관계 관리자

서비스 수준 서비스 수준 계약에 대한 서비스 수준

현재 상태 현재 평가 기간에 대한 서비스 수준 계약의 
준수 상태(준수 또는 위반)

드릴다운 특정 서비스 수준 계약에 대한 정보를 표시하려면 드
릴다운 버튼을 클릭합니다.

평가 기간

평가 기간
(선택 상자)

드릴다운된 서비스 수준 계약에 대한 평가 기간

현재 기간에 대한 SLA 요약

시작 날짜 선택한 평가 기간의 시작 날짜
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종료 날짜 선택한 평가 기간의 종료 날짜

최신 상태 선택한 평가 기간에 대한 드릴다운된 서비스 
수준 계약의 최신 준수 상태

최신 상태 날짜 드릴다운된 서비스 수준 계약의 
최신 준수 상태가 계산된 날짜 및 시간

서비스

서비스
(선택 상자)

서비스 수준 계약과 연관된 서비스

현재 기간에 대한 서비스 요약

설명 선택한 서비스 설명

최신 준수 상태 선택한 평가 기간에 대한 선택한 서비스의 
최신 준수 상태

최신 상태 날짜 선택한 평가 기간에 대해 최신 상태가 계산된 날짜

서비스 준수 상태 
분포

선택한 평가 기간에 대한 일일 준수 상태
(준수 및 위반) 퍼센트의 그래픽 표시

서비스 인프라 
가용성 상태 분포

선택한 평가 기간의 인프라 가용성 서비스 
측정 항목에 대한 퍼센트(처리됨, 처리되지 않음 
및 아직 계산되지 않음) 그래픽 표시

표 6-4 고객 비즈니스 관리자 보고서 필드에 대한 SLA 세부사항

필드 설명
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그림 6-9 고객 비즈니스 관리자 샘플 보고서에 대한 SLA 세부사항
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고객 비즈니스 관리자에 대한 서비스 세부사항

이 보고서는 특정 서비스와 연관된 서비스 측정 항목 상태 세부사항을 
제공합니다.

보고서 스케줄

• 주문식

• 예약됨(매일, 매주 또는 매월), 사용자가 구성할 수 있음

보고서 필드

표 6-5 고객 비즈니스 관리자 보고서 필드에 대한 서비스 세부사항

필드 설명

활성 SLA 목록

SLA 고객 관계 관리자(지정된 경우) 또는 모든 서비스 
수준 계약(고객 관계 관리자가 지정되지 않은 경우)
과 연관된 서비스 수준 계약 목록.

CRM 서비스 수준 계약과 연관된 고객 관계 관리자

서비스 수준 서비스 수준 계약에 대한 서비스 수준

현재 상태 현재 평가 기간에 대한 서비스 수준 계약의 
준수 상태(준수 또는 위반)

드릴다운 특정 서비스 수준 계약에 대한 정보를 표시하려면 드
릴다운 버튼을 클릭합니다.

평가 기간

평가 기간
(선택 상자)

드릴다운된 서비스 수준 계약에 대한 평가 기간

현재 기간에 대한 SLA 요약

시작 날짜 선택한 평가 기간의 시작 날짜

종료 날짜 선택한 평가 기간의 종료 날짜
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미리 구성된 SLM 보고서
최신 상태 선택한 평가 기간에 대한 드릴다운된 서비스 
수준 계약의 최신 준수 상태

최신 상태 날짜 드릴다운된 서비스 수준 계약의 
최신 준수 상태가 계산된 날짜 및 시간

서비스

서비스
(선택 상자)

서비스 수준 계약과 연관된 서비스

현재 기간에 대한 서비스 요약

설명 선택한 서비스 설명

최신 준수 상태 선택한 평가 기간에 대한 선택한 서비스의 
최신 준수 상태

최신 상태 날짜 선택한 평가 기간에 대해 최신 상태가 계산된 날짜

현재 서비스에 대한 서비스 측정 항목 목록

이름 서비스 측정 항목의 이름

최신 준수 서비스 측정 항목의 최신 준수 상태

최신 날짜 최신 서비스 측정 항목 상태가 계산된 날짜 및 시간

드릴다운 특정 서비스 측정 항목에 대한 측정 항목 값 정보를 
표시하려면 드릴다운 버튼을 클릭합니다.

측정 항목 값 드릴다운된 서비스 측정 항목의 시간에 대한 
최대 측정 항목 값, 최소 측정 항목 값, 
준수 측정 항목 값의 그래픽 표시

표 6-5 고객 비즈니스 관리자 보고서 필드에 대한 서비스 세부사항

필드 설명
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그림 6-10 고객 비즈니스 관리자 샘플 보고서에 대한 서비스 세부사항
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미리 구성된 SLM 보고서
고객 비즈니스 관리자에 대한 SLO 세부사항

이 보고서는 서비스와 연관된 서비스 수준 목표에 대한 정보를 제공합니다.

보고서 스케줄

• 주문식

• 예약됨(매일, 매주 또는 매월), 사용자에 의해 구성됨

보고서 필드

표 6-6 고객 비즈니스 관리자 보고서 필드에 대한 SLO 세부사항

필드 설명

활성 SLA 목록

SLA 고객 관계 관리자(지정된 경우) 또는 모든 서비스 
수준 계약(고객 관계 관리자가 지정되지 않은 경우)
과 연관된 서비스 수준 계약 목록.

CRM 서비스 수준 계약과 연관된 고객 관계 관리자

서비스 수준 서비스 수준 계약에 대한 서비스 수준

현재 상태 현재 평가 기간에 대한 서비스 수준 계약의 
준수 상태(준수 또는 위반)

드릴다운 특정 서비스 수준 계약에 대한 정보를 표시하려면 드
릴다운 버튼을 클릭합니다.

평가 기간

평가 기간
(선택 상자)

드릴다운된 서비스 수준 계약에 대한 평가 기간

현재 기간에 대한 SLA 요약

시작 날짜 선택한 평가 기간의 시작 날짜

종료 날짜 선택한 평가 기간의 종료 날짜
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최신 상태 선택한 평가 기간에 대한 드릴다운된 
서비스 수준 계약의 최신 준수 상태

최신 상태 날짜 드릴다운된 서비스 수준 계약의 
최신 준수 상태가 계산된 날짜 및 시간

서비스

서비스
(선택 상자)

서비스 수준 계약과 연관된 서비스

현재 기간에 대한 서비스 요약

설명 선택한 서비스 설명

최신 준수 상태 선택한 평가 기간에 대한 선택한 서비스의 
최신 준수 상태

최신 상태 날짜 선택한 평가 기간에 대해 최신 상태가 
계산된 날짜

현재 서비스에 대한 서비스 측정 항목 목록

이름 서비스 측정 항목의 이름

준수 상태 서비스 측정 항목의 준수 상태

범주 서비스 측정 항목의 범주
(표준, 집계됨 또는 인프라)

달성된 준수 서비스 측정 항목이 달성한 집계된 준수 값

목표 준수 서비스 측정 항목에 대한 준수 위반 임계치 값

드릴다운 특정 서비스 측정 항목에 대한 측정 항목 값 
정보를 표시하려면 드릴다운 버튼을 
클릭합니다.

서비스 측정 항목 준수 퍼센트 분포

표 6-6 고객 비즈니스 관리자 보고서 필드에 대한 SLO 세부사항

필드 설명
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서비스 측정 항목 
준수 퍼센트 분포

선택된 평가 기간에서 처리된 준수 값의 
그래픽 표시.

표 6-6 고객 비즈니스 관리자 보고서 필드에 대한 SLO 세부사항

필드 설명
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미리 구성된 SLM 보고서
그림 6-11 고객 비즈니스 관리자 샘플 보고서에 대한 SLO 세부사항
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미리 구성된 SLM 보고서
고객 관계 관리자에 대한 SLA 개요

이 보고서는 특정 보고 간격으로 대상 사용자에게 연관된 서비스 수준 계약에 
대한 모든 개요 정보를 제공합니다.

보고서 스케줄

• 주문식

• 예약됨(매일, 매주 또는 매월), 사용자에 의해 구성됨

보고서 필드

표 6-7 고객 관계 관리자 보고서 필드에 대한 SLA 개요

필드 설명

활성 SLA 목록

SLA 고객 비즈니스 관리자(지정된 경우) 또는 
모든 서비스 수준 계약(고객 비즈니스 관리자가 
지정되지 않은 경우)과 연관된 서비스 수준 계약 
목록. 고객 관계 관리자에 대한 SLA 세부사항 
보고서에 연결하려는 서비스 수준 계약을 클릭
합니다.

CRM 서비스 수준 계약과 연관된 고객 관계 관리자

서비스 수준 서비스 수준 계약에 대한 서비스 수준

현재 상태 현재 평가 기간에 대한 서비스 수준 계약의 
준수 상태(준수, 위험 또는 위반)

예측 상태 현재 평가 기간의 마지막에 도달할 것으로 
예측된 준수 상태(준수, 위험 또는 위반)

드릴다운 특정 서비스 수준 계약에 대한 정보를 표시하려면 드
릴다운 버튼을 클릭합니다.

평가 기간

평가 기간
(선택 상자)

드릴다운된 서비스 수준 계약에 대한 평가 기간
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현재 기간에 대한 SLA 요약

시작 날짜 선택한 평가 기간의 시작 날짜

종료 날짜 선택한 평가 기간의 종료 날짜

최신 상태 선택한 평가 기간에 대한 최신 준수 상태
(준수, 위험 또는 위반)

최신 상태 날짜 최신 준수 상태가 계산된 날짜

서비스 및 서비스 수준 목표

서비스 서비스 수준 계약과 연관된 서비스

준수 SLO 서비스와 연관된 서비스 측정 항목

준수 목표 서비스 측정 항목에 대한 준수 위반 임계치 값

실제 준수 선택한 평가 기간에 대해 서비스 측정 항목이 
달성한 준수 값

준수 상태 선택한 평가 기간에 대한 서비스 측정 항목의 
준수 상태(준수, 위험 또는 위반)

표 6-7 고객 관계 관리자 보고서 필드에 대한 SLA 개요

필드 설명
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미리 구성된 SLM 보고서
그림 6-12 고객 관계 관리자 샘플 보고서에 대한 SLA 개요
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미리 구성된 SLM 보고서
고객 관계 관리자에 대한 SLA 세부사항

이 보고서는 특정 보고 간격 동안 특정 서비스 수준 계약에 대한 준수 상태 
세부사항을 보여줍니다.

보고서 스케줄

• 주문식

• 예약됨(매일, 매주 또는 매월), 사용자에 의해 구성됨

보고서 필드

표 6-8 고객 관계 관리자 보고서 필드에 대한 SLA 세부사항

필드 설명

활성 SLA 목록

SLA 고객 관계 관리자(지정된 경우) 또는 
모든 서비스 수준 계약(고객 관계 관리자가 
지정되지 않은 경우)과 연관된 서비스 수준 계약 
목록. 고객 관계 관리자에 대한 SLO 세부사항 
보고서에 연결하려는 서비스 수준 계약을 클릭
합니다.

CRM 서비스 수준 계약과 연관된 고객 관계 관리자

서비스 수준 서비스 수준 계약에 대한 서비스 수준

현재 상태 현재 평가 기간에 대한 서비스 수준 계약의 
준수 상태(준수, 위험 또는 위반)

예측 상태 현재 평가 기간의 마지막에 도달할 것으로 예측된 준
수 상태(준수, 위험 또는 위반)

드릴다운 특정 서비스 수준 계약에 대한 정보를 표시하려면 드
릴다운 버튼을 클릭합니다.

평가 기간

평가 기간
(선택 상자)

드릴다운된 서비스 수준 계약에 대한 평가 기간
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현재 기간에 대한 SLA 요약

시작 날짜 선택한 평가 기간의 시작 날짜

종료 날짜 선택한 평가 기간의 종료 날짜

최신 상태 선택한 평가 기간에 대한 최신 상태.

최신 상태 날짜 최신 상태가 계산된 날짜 및 시간

서비스

서비스
(선택 상자)

서비스 수준 계약과 연관된 서비스

현재 기간에 대한 서비스 요약

설명 선택한 서비스 설명

최신 준수 상태 선택한 평가 기간에 대한 선택한 서비스의 
최신 준수 상태

최신 상태 날짜 선택한 평가 기간에 대해 최신 상태가 계산된 날짜

서비스 준수 상태 
분포

선택한 평가 기간에 대한 일일 준수 상태
(준수, 위험 및 위반) 퍼센트의 그래픽 표시

서비스 인프라 
가용성 상태 분포

선택한 평가 기간의 인프라 가용성 서비스 
측정 항목에 대한 퍼센트(처리됨, 처리되지 않음 
및 아직 계산되지 않음) 그래픽 표시

표 6-8 고객 관계 관리자 보고서 필드에 대한 SLA 세부사항

필드 설명
6장124



SLM 보고
미리 구성된 SLM 보고서
그림 6-13 고객 관계 관리자 샘플 보고서에 대한 SLA 세부사항
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미리 구성된 SLM 보고서
고객 관계 관리자에 대한 서비스 세부사항

이 보고서는 특정 서비스와 연관된 서비스 측정 항목 상태 세부사항을 
제공합니다.

보고서 스케줄

• 주문식

• 예약됨(매일, 매주 또는 매월), 사용자가 구성할 수 있음

보고서 필드

표 6-9 고객 관계 관리자 보고서 필드에 대한 서비스 세부사항

필드 설명

활성 SLA 목록

SLA 고객 관계 관리자(지정된 경우) 또는 
모든 서비스 수준 계약(고객 관계 관리자가 
지정되지 않은 경우)과 연관된 서비스 수준 
계약 목록.

CRM 서비스 수준 계약과 연관된 고객 관계 관리자

서비스 수준 서비스 수준 계약에 대한 서비스 수준

현재 상태 현재 평가 기간에 대한 서비스 수준 계약의 
준수 상태(준수, 위험 또는 위반)

예측 상태 현재 평가 기간의 마지막에 도달할 것으로 예측된 준
수 상태(준수, 위험 또는 위반)

드릴다운 특정 서비스 수준 계약에 대한 정보를 표시하려면 드
릴다운 버튼을 클릭합니다.

평가 기간

평가 기간
(선택 상자)

드릴다운된 서비스 수준 계약에 대한 평가 기간

현재 기간에 대한 SLA 요약
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시작 날짜 선택한 평가 기간의 시작 날짜

종료 날짜 선택한 평가 기간의 종료 날짜

최신 상태 선택한 평가 기간에 대한 드릴다운된 
서비스 수준 계약의 최신 준수 상태

최신 상태 날짜 드릴다운된 서비스 수준 계약의 
최신 준수 상태가 계산된 날짜 및 시간

서비스

서비스
(선택 상자)

서비스 수준 계약과 연관된 서비스

현재 기간에 대한 서비스 요약

설명 선택한 서비스 설명

최신 준수 상태 선택한 평가 기간에 대한 선택한 서비스의 
최신 준수 상태

최신 상태 날짜 선택한 평가 기간에 대해 최신 준수 상태가 
계산된 날짜

현재 서비스에 대한 서비스 측정 항목 목록

이름 서비스 측정 항목의 이름

최신 준수 서비스 측정 항목의 최신 준수 상태

최신 날짜 최신 서비스 측정 항목 준수 상태가 계산된 
날짜 및 시간

드릴다운 특정 서비스 측정 항목에 대한 측정 항목 값 
정보를 표시하려면 드릴다운 버튼을 
클릭합니다.

표 6-9 고객 관계 관리자 보고서 필드에 대한 서비스 세부사항

필드 설명
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측정 항목 값 드릴다운된 서비스 측정 항목의 시간에 대한 
최대 측정 항목 값, 최소 측정 항목 값, 
준수 측정 항목 값의 그래픽 표시

표 6-9 고객 관계 관리자 보고서 필드에 대한 서비스 세부사항

필드 설명
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그림 6-14 고객 관계 관리자 샘플 보고서에 대한 서비스 세부사항
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고객 관계 관리자에 대한 SLO 세부사항

이 보고서는 서비스와 연관된 서비스 수준 목표에 대한 정보를 제공합니다.

보고서 스케줄

• 주문식

• 예약됨(매일, 매주 또는 매월), 사용자에 의해 구성됨

보고서 필드

표 6-10 고객 관계 관리자 보고서 필드에 대한 SLO 세부사항

필드 설명

활성 SLA 목록

SLA 고객 비즈니스 관리자(지정된 경우) 또는 
모든 서비스 수준 계약(고객 비즈니스 관리자가 
지정되지 않은 경우)과 연관된 서비스 수준 계약 
목록. 고객 관계 관리자에 대한 SLA 세부사항 
보고서에 연결하려는 서비스 수준 계약을 클릭
합니다.

CRM 서비스 수준 계약과 연관된 고객 관계 관리자

서비스 수준 서비스 수준 계약에 대한 서비스 수준

현재 상태 현재 평가 기간에 대한 서비스 수준 계약의 
준수 상태(준수, 위험 또는 위반)

예측 상태 현재 평가 기간의 마지막에 도달할 것으로 예측된 준
수 상태(준수, 위험 또는 위반)

드릴다운 특정 서비스 수준 계약에 대한 정보를 표시하려면 드
릴다운 버튼을 클릭합니다.

평가 기간

평가 기간
(선택 상자)

드릴다운된 서비스 수준 계약에 대한 평가 기간
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현재 기간에 대한 SLA 요약

시작 날짜 선택한 평가 기간의 시작 날짜

종료 날짜 선택한 평가 기간의 종료 날짜

최신 상태 선택한 평가 기간에 대한 드릴다운된 
서비스 수준 계약의 최신 준수 상태

최신 상태 날짜 드릴다운된 서비스 수준 계약의 
최신 준수 상태가 계산된 날짜 및 시간

서비스

서비스
(선택 상자)

서비스 수준 계약과 연관된 서비스

현재 기간에 대한 서비스 요약

설명 선택한 서비스 설명

최신 준수 상태 선택한 평가 기간에 대한 선택한 서비스의 
최신 준수 상태

최신 목표 상태 선택한 평가 기간에 대해 선택한 서비스의 
최신 목표 상태

최신 상태 날짜 최신 상태가 계산된 날짜

현재 서비스에 대한 서비스 측정 항목 목록

이름 서비스 측정 항목의 이름

준수 상태 서비스 측정 항목의 준수 상태

범주 서비스 측정 항목의 범주
(표준, 집계됨 또는 인프라)

달성된 준수 서비스 측정 항목이 달성한 집계된 준수 값

목표 준수 서비스 측정 항목에 대한 준수 위반 임계치 값

표 6-10 고객 관계 관리자 보고서 필드에 대한 SLO 세부사항

필드 설명
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드릴다운 특정 서비스 측정 항목에 대한 측정 항목 값 
정보를 표시하려면 드릴다운 버튼을 
클릭합니다.

서비스 측정 항목 준수 퍼센트

참조 준수 임계치의 이름

목표 준수 임계치에 대한 목표 임계치 값 및 연산자

심각도 준수 임계치의 심각도

서비스 측정 항목 준수 퍼센트 분포

서비스 측정 항목 
준수 퍼센트 분포

선택된 평가 기간에서 처리된 준수 값의 
그래픽 표시.

표 6-10 고객 관계 관리자 보고서 필드에 대한 SLO 세부사항

필드 설명
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그림 6-15 고객 관계 관리자 샘플 보고서에 대한 SLO 세부사항
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서비스 관리자에 대한 서비스 개요

이 보고서는 요약 정보와 함께 대상 사용자가 관리하는 모든 서비스 목록을 제
공합니다.

대상 사용자

• 서비스 관리자(Service Manager)

• 서비스 관리자(Service Administrator)

보고서 스케줄

• 주문식

• 예약됨(매일, 매주 또는 매월), 사용자가 구성할 수 있음

보고서 필드

표 6-11 서비스 관리자 보고서 필드에 대한 서비스 개요

필드 설명

활성 서비스 목록

서비스 서비스 이름. 서비스 세부 항목 보고서(서비스 
관리자)에 연결하려는 서비스를 클릭합니다.

설명 서비스 설명

서비스 관리자 서비스에 할당된 서비스 관리자

드릴다운 특정 서비스에 대한 정보를 표시하려면 드릴다운 
버튼을 클릭합니다.

연관된 SLA
(선택 상자)

드릴다운 서비스와 연관된 서비스 수준 계약

연관된 서비스 준수 상태

마지막 준수 상태 마지막으로 알려진 서비스 준수 상태(준수, 위험 
및 위반)의 신호등과 계산된 상태의 날짜 및 시간
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마지막 예측 
준수 상태

마지막으로 알려진 예측 서비스 준수 상태
(준수, 위험 및 위반)의 신호등과 계산된 상태의 
날짜 및 시간

서비스 가용성 상태 분포

기간
(선택 상자)

선택한 시간 기간에 따라 처리됨, 처리되지 않음 및 
아직 계산되지 않음 섹션에서 서비스 가용성을 보여
주는 아래 그래프의 기간. 분, 시간 또는 일 단위로 그
래프 보기를 선택할 수 있습니다. 서비스 시간 스케
줄에 따라, 서비스되지 않음 상태인 서비스 기간은 
막대 차트에서 어두운 부분으로 나타납니다.

5분 간격 
서비스 가용성

마지막 두 시간에 현재 순간까지의 현재 시간을 더한 
기본 기간 또는 그래픽 편집 버튼을 사용하여 
지정한 기간에 대한 5분 간격의 서비스 가용성.

시간별 서비스 
가용성

마지막 날짜에 현재 순간까지의 현재 날짜를 더한 기
본 기간 또는 그래픽 편집 버튼을 사용하여 지정한 
기간에 대한 시간별 서비스 가용성.

일별 서비스 
가용성

마지막 달에 현재 순간까지의 현재 달을 더한 기본 
기간 또는 그래픽 편집 버튼을 사용하여 지정한 
기간에 대한 일별 서비스 가용성.

표 6-11 서비스 관리자 보고서 필드에 대한 서비스 개요

필드 설명
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그림 6-16 서비스 관리자 샘플 보고서에 대한 서비스 개요
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미리 구성된 SLM 보고서
서비스 관리자에 대한 서비스 세부사항

이 보고서는 선택한 서비스에 대한 서비스 측정 항목에 대한 정보뿐 아니라 기
반 서비스 및 구성 항목에 대한 목록과 연결을 제공합니다.

보고서 스케줄

• 주문식

• 예약됨(매일, 매주 또는 매월), 사용자가 구성할 수 있음

보고서 필드

표 6-12 서비스 관리자 보고서 필드에 대한 서비스 세부사항

필드 설명

서비스 정보

서비스 서비스 이름 

서비스 관리자 서비스에 할당된 서비스 관리자

마지막 가용성... 가장 최근에 계산된 서비스에 대한 현재 가용성 
상태

SLA에 대한 ... 서비스와 연관된 서비스 수준 계약

드릴다운 특정 서비스에 대한 정보를 표시하려면 드릴다운 
버튼을 클릭합니다.

기반 서비스 목록

서비스 하위 서비스의 이름

서비스 관리자 서비스에 할당된 서비스 관리자

마지막 가용성 
상태

가장 최근에 계산된 서비스에 대한 현재 가용성 
상태

기반 구성 항목 목록

구성 항목 하위 구성 항목의 이름
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마지막 가용성 
상태

가장 최근에 계산된 CI에 대한 현재 가용성 상태

서비스 측정 항목 목록

측정 항목 이름 측정 항목의 이름

설명 측정 항목의 설명

단위 측정 항목 데이터 값의 단위

범주 측정 항목의 범주(예: 표준)

측정 항목 값 분포

5분 간격 측정 
항목 값

마지막 두 시간에 현재 순간까지의 현재 시간을 
더한 기본 기간 또는 그래픽 편집 버튼을 사용하여 
지정한 기간에 대한 5분 간격의 측정 항목 값.

시간별 측정 
항목 값

마지막 날짜에 현재 순간까지의 현재 시간을 더한 기
본 기간 또는 그래픽 편집 버튼을 사용하여 지정한 
기간에 대한 시간별 측정 항목 값.

일간 측정 항목 값 마지막 달에 현재 순간까지의 현재 달을 더한 기본 
기간 또는 그래픽 편집 버튼을 사용하여 지정한 
기간에 대한 일간 측정 항목 값.

표 6-12 서비스 관리자 보고서 필드에 대한 서비스 세부사항

필드 설명
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그림 6-17 서비스 관리자 샘플 보고서에 대한 서비스 세부사항
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서비스 관리자에 대한 구성 항목 세부사항

이 보고서는 주어진 구성 항목에 대한 자세한 정보를 제공합니다. 일반적으로 
대상 사용자는 고객 관계 관리자에 대한 서비스 세부사항 보고서에서 이 보고
서로 연결합니다.

대상 사용자

• 서비스 관리자

보고서 스케줄

• 주문식

• 예약됨(매일, 매주 또는 매월), 사용자가 구성할 수 있음

보고서 필드

표 6-13 구성 항목 세부사항 보고서 필드

필드 설명

구성 항목 정보

이름 구성 항목의 이름

최신 가용성... 가장 최근에 계산된 구성 항목에 대한 
현재 가용성 상태

SLA에 대한 ... 구성 항목과 연관된 서비스 수준 계약

서비스 수준 서비스 수준 계약과 연관된 서비스 수준

고객 서비스 수준 계약과 연관된 서비스 수신자

드릴다운 구성 항목과 서비스 수준 계약의 특정 조합에 
대한 정보를 표시하려면 드릴다운 버튼을 
클릭합니다.

구성 항목 가용성 분포
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5분 간격 CI 
가용성

마지막 두 시간에 현재 순간까지의 현재 시간을 
더한 기본 기간 또는 그래픽 편집 버튼을 사용하여 
지정한 기간에 대한 5분 간격의 CI 가용성.

시간별 CI 가용성 마지막 날짜에 현재 순간까지의 현재 시간을 더한 기
본 기간 또는 그래픽 편집 버튼을 사용하여 지정한 
기간에 대한 시간별 CI 가용성.

일간 CI 가용성 마지막 달에 현재 순간까지의 현재 달을 더한 기본 
기간 또는 그래픽 편집 버튼을 사용하여 지정한 
기간에 대한 일간 CI 가용성.

구성 항목 측정 항목 목록

측정 항목 이름 측정 항목의 이름

측정 항목 단위 측정 항목 데이터 값의 단위

측정 항목 값 분포

5분 간격 측정 
항목 값

마지막 두 시간에 현재 순간까지의 현재 시간을 
더한 기본 기간 또는 그래픽 편집 버튼을 사용하여 
지정한 기간에 대한 5분 간격의 측정 항목 값.

시간별 측정 
항목 값

마지막 날짜에 현재 순간까지의 현재 시간을 더한 기
본 기간 또는 그래픽 편집 버튼을 사용하여 지정한 
기간에 대한 시간별 측정 항목 값.

일간 측정 항목 값 마지막 달에 현재 순간까지의 현재 달을 더한 기본 
기간 또는 그래픽 편집 버튼을 사용하여 지정한 
기간에 대한 일간 측정 항목 값.

표 6-13 구성 항목 세부사항 보고서 필드

필드 설명
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그림 6-18 구성 항목 세부사항 샘플 보고서
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PDF 및 SREP 형식으로 SLM 보고서 작성
표준 OVPI 기능을 사용하여 SLM 보고서의 정적 버전을 작성할 수 있습니다. 
자세한 내용은 OVPI 설명서를 참조하십시오. PDF 양식으로 정적 보고서를 작
성할 때 보고서 시스템은 모든 드릴다운 조합을 탐색하고 각 조합마다 한 페이
지를 생성합니다. 미리 구성된 SLM 보고서의 대화형 특징 때문에 너무 큰 PDF 
문서가 생길 수 있습니다. 따라서 특정 SLM 보고서는 PDF 및 SREP로 생성할 
수 있습니다. 이러한 버전은 106페이지의 "미리 구성된 SLM 보고서"에 기재된 
보고서를 기반으로 하지만 포함된 드릴다운 옵션이 적으므로 정적 출력 파일
도 적습니다.

SLM 보고서의 정적 버전은 성능 파악 표준 뷰어 또는 웹 액세스 서버에 있는 
SLM Reporting/Static 폴더에서 사용할 수 있습니다. 표 6-14에는 사용할 
수 있는 보고서의 범주가 기재되어 있습니다．

표 6-14 정적 SLM 보고서의 범주

범주 사용 가능한 보고서 그래프에 대한 시간대 데이터 밀도

시간별 모든 인프라 보고서
(서비스 개요, 
서비스 세부사항 및 
CI 세부사항)

이전 시간 5분 간격

매일 모든 인프라 보고서 전날 시간별

매주 모든 인프라 보고서 전주 매일

매월 모든 인프라 보고서 전달 매일

평가 기간 모든 SLA 기반 보고서
(SLA 개요, 
SLA 세부사항, 
SLO 세부사항 및 
서비스 세부사항)

이전 SLA 평가 기간 매일
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정적 보고서 시간대 사용자 지정

평가 기간을 제외한 모든 정적 보고서 범주에 대해 그래프의 시간대를 사용자 
지정할 수 있습니다. 이 방식은 보고서 액세스 방법에 따라 차이가 있습니다．

OVPI 표준 뷰어

1. 그래프를 마우스 오른쪽 버튼으로 클릭합니다. 

2. "시간대 설정..."을 선택합니다. 

3. 대화 상자에서 필요한 시간대를 지정합니다.

OVPI 웹 서버

1. 그래프의 오른쪽 상단에 있는 그래프 편집 아이콘을 클릭합니다.

2. 대화 상자에서 필요한 시간대를 지정합니다.

주 요소 편집이 가능한 경우에만 그래프 편집 아이콘이 나타납니다. 요소 편집을 
활성화하려면 브라우저의 오른쪽 상단에 있는 등록 정보 메뉴를 클릭하여 배
치된 항목을 확장한 후 뷰를 클릭하고 요소 편집 허용 확인란을 선택합니다.

내장된 보고서 뷰어

정적 SLM 보고서 액세스는 현재 OpenView 콘솔에 내장된 보고서 뷰어에서 지
원되지 않습니다. 
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7 SLM 시나리오

이 장에서는 서비스 수준 매니저의 기능을 묘사하는 시나리오를 설명합니다.
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시나리오 1: 측정 항목 구성 및 검색
이 시나리오는 SLM 관리자가 측정 항목 어댑터를 구성하고 측정 항목 검색을 
실시하는 절차를 시연합니다. 필요한 모든 제품 구성 요소는 설치되어 있는 것
으로 가정합니다.

SLM 관리자는 서비스 수준 매니저로부터 다음과 같은 OVIS(HP OpenView 인
터넷 서비스) 측정 유형을 제공해 달라는 요청을 받습니다. 

• ICMP(특정 구성 항목의 가용성 측정)

• HTTP(특정 웹 페이지를 지원하는 웹 서비스 및 응답 시간의 가용성 측정)

측정 항목 어댑터 구성

OVIS가 설치된 호스트에 OVIS 측정 항목 어댑터를 설치한 후 SLM 관리자는 
측정 항목 어댑터를 구성해야 합니다. <설치 디렉토리>\data\conf\
OvisMA.xml 파일을 편집하면 이를 구성할 수 있습니다. 

그림 7-2는 구성 파일의 최초 내용을 보여줍니다. 굵은 글씨체로 표시된 다음 
문자열은 설치 전용 값으로 교체해야 합니다. 표 7-1에는 제공되어야 하는 값
이 기재되어 있습니다.

그림 7-1 구성 파일의 최초 내용

<?xml version="1.0" encoding="UTF-8"?>

<Config>

    <MA name="OvisMA">

        <Publisher.APP_NAME>OvisMAPublisher</Publisher.APP_NAME>

        <DefaultTaskPollingPeriod>300</DefaultTaskPollingPeriod>

        <DiscoveryMaxHistory>10080</DiscoveryMaxHistory>

        <DataPointVersionByte>1</DataPointVersionByte>

        <ServerHost>$SLM_HOSTNAME$</ServerHost>

        <TypeByte>1</TypeByte>

        <isEventBased>0</isEventBased>

        <SequenceNumber>0</SequenceNumber>
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        <Publisher.RESPONSE_TIMEOUT>60</Publisher.RESPONSE_TIMEOUT>

        <DiscoveryInterval>3600</DiscoveryInterval>

        <MrpDefinitionDiscoveryInterval>86400</MrpDefinitionDiscoveryInterval>

        <HeartBeatsInterval>300</HeartBeatsInterval>

        <DefaultTaskExpirePeriod>600</DefaultTaskExpirePeriod>

        <DataPointSynchronizationDelay>600</DataPointSynchronizationDelay>

    </MA>

    <Connector name="$OVIS_HOSTNAME$">

        <Timeout>10</Timeout>

        <Password>openview</Password>

        <Host>$OVIS_HOSTNAME$</Host>

        <Class>com.hp.ov.sd.slm.sa.ovis.Connector</Class>

        <URL>jdbc:inetdae7:$OVIS_HOSTNAME$:$OVIS_PORT$</URL>

        <DBName>reporter</DBName>

        <DriverName>com.inet.tds.TdsDriver</DriverName>

        <Table>IOPS_DETAIL_DATA</Table>

        <Port>$OVIS_PORT$</Port>

        <Login>openview</Login>

        <nbReconnection>10</nbReconnection>

    </Connector>

    <DiscoveryLocationFilter>

        <All/>

    </DiscoveryLocationFilter>

</Config>
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SLM 관리자는 구성 파일에서 다음과 같은 기본 텍스트 문자열을 교체해야 합
니다.

정확한 OVIS_PORT 값을 확인하기 위해 SLM 관리자는 다음 어플리케이션을 
실행해야 합니다. 
C:\Program Files\Microsoft MS SQL Server\80\Tools\Binn\

SVRNETCN.exe. 정확한 포트 번호는 TCP/IP 속성 대화 상자에 표시되어 
있습니다.

그림 7-2 정확한 OVIS 포트 식별

표 7-1

기본 텍스트 문자열 교체된 텍스트 문자열

$SLM_HOSTNAME SLM 서버의 호스트 이름 또는 IP 주소.

$OVIS_HOSTNAME OVIS 서버의 호스트 이름 또는 IP 주소.

$OVIS_PORT OVIS 데이터베이스 연결을 위한 포트 번호.
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이 시나리오에서 SLM 서버 절차는 이름이 SLM인 호스트에서 실행되며 OVIS 
측정 항목 어댑터와 같은 호스트에 OVIS가 설치되어 있으므로 OVIS 호스트
는 LOCALHOST로 설정되어 있고 필수 OVIS 포트 번호는 1151로 
식별됩니다(그림 7-2 참조).

이 값을 적용하려면, SLM 관리자는 명령 프롬프트에서 다음 명령을 실행하여 
측정 항목 어댑터 구성 유틸리티를 시작해야 합니다.

<install_dir>\bin\startMAConfigGui.bat

공유 매개 변수 탭 페이지가 나타납니다. SLM 관리자는 값 필드에 SLM 서버
의 호스트 이름을 입력하여 이 서버에 설치된 각각의 측정 항목 어댑터가 식별
된 SLM 서버로 측정 항목 데이터 값을 보내야 한다는 점을 표시합니다.

그림 7-3 측정 항목 어댑터 구성 유틸리티(공유 매개 변수)

SLM 관리자는 OvisMA 탭 페이지를 클릭하고 OVIS 호스트 이름과 포트에 정
확한 값을 입력합니다. 업데이트된 구성 파일이 인접한 XML 패널에 표시됩니
다.
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그림 7-4 측정 항목 어댑터 구성 유틸리티(OvisMA 매개 변수)

마지막으로 SLM 관리자는 모두 저장을 클릭한 후 파일 →종료를 클릭하여 설
정을 저장하고 유틸리티를 닫습니다. 그림 7-5는 OVIS 측정 항목 어댑터의 편
집된 구성 파일을 보여줍니다.

그림 7-5 편집된 구성 파일

<?xml version="1.0" encoding="UTF-8"?>

<Config>

    <MA name="OvisMA">

        <Publisher.APP_NAME>OvisMAPublisher</Publisher.APP_NAME>

        <DefaultTaskPollingPeriod>300</DefaultTaskPollingPeriod>

        <DiscoveryMaxHistory>10080</DiscoveryMaxHistory>

        <DataPointVersionByte>1</DataPointVersionByte>

        <ServerHost>SLM</ServerHost>

        <TypeByte>1</TypeByte>

        <isEventBased>0</isEventBased>

        <SequenceNumber>0</SequenceNumber>
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        <Publisher.RESPONSE_TIMEOUT>60</Publisher.RESPONSE_TIMEOUT>

        <DiscoveryInterval>3600</DiscoveryInterval>

        <MrpDefinitionDiscoveryInterval>86400</MrpDefinitionDiscoveryInterval>

        <HeartBeatsInterval>300</HeartBeatsInterval>

        <DefaultTaskExpirePeriod>600</DefaultTaskExpirePeriod>

        <DataPointSynchronizationDelay>600</DataPointSynchronizationDelay>

    </MA>

    <Connector name="LOCALHOST">

        <Timeout>10</Timeout>

        <Password>openview</Password>

        <Host>LOCALHOST</Host>

        <Class>com.hp.ov.sd.slm.sa.ovis.Connector</Class>

        <URL>jdbc:inetdae7:LOCALHOST:1151</URL>

        <DBName>reporter</DBName>

        <DriverName>com.inet.tds.TdsDriver</DriverName>

        <Table>IOPS_DETAIL_DATA</Table>

        <Port>1151</Port>

        <Login>openview</Login>

        <nbReconnection>10</nbReconnection>

    </Connector>

    <DiscoveryLocationFilter>

        <All/>

    </DiscoveryLocationFilter>

</Config>

초기 측정 항목 검색 억제

초기 측정 항목 검색을 억제하려면 SLM 관리자가 텍스트 편집기에서 다음 파
일을 엽니다. 

<HP OpenView 설치 디렉토리>/misc/xpl/config/defaults/slm.ini
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bool OvisMAdiscoverAll=true 문자열이 있는 라인에서 SLM 관리자가 
OvisMAdiscoverAll 매개 변수 값을 true에서 false로 바꿉니다.

SLM 관리자는 이제 OpenView 콘솔에 측정 항목 어댑터를 등록하고 측정 
항목 정의 검색을 트리거링할 준비가 되었습니다.

측정 항목 정의 검색 트리거링

OpenView 콘솔에서 측정 항목 어댑터를 등록하고 측정 항목 정의 검색을 
트리거링하려면 SLM 관리자는 명령 프롬프트에서 다음 명령을 실행하여 
SLM 서버를 먼저 시작해야 합니다.

ovc -start ovsdslm

이제 SLM 관리자가 OVIS 측정 항목 어댑터를 시작합니다.

ovc -start ovisma

SLM 관리자는 OVIS 측정 항목 정의 작업영역을 탐색하여 측정 항목 정의 검
색 절차가 OVIS에서 구성된 프로브를 나타내는 객체를 작성했는지 확인합니
다.

그림 7-6 발견된 OVIS 측정 항목 정의
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측정 항목 검색 트리거링

이제 측정 항목을 발견했으며 SLM 관리자는 측정 항목 검색 필터링을 구성하고 
측정 항목 검색을 트리거링할 수 있습니다. 이를 통해 측정 항목 어댑터는 발견
될 측정 항목에 대한 측정 항목 정의를 지정하는 필터에 연결되어야 합니다.

SLM 관리자는 양식에서 OVIS 측정 항목 어댑터를 열고 검색 필터 패널에서 
새로 만들기 버튼을 클릭합니다.

그림 7-7 측정 항목 어댑터에 검색 필터 연결

SLM 관리자는 검색 필터 양식에서 측정 항목 정의 패널에 있는 연결 버튼을 
클릭합니다.

그림 7-8 검색 필터에 측정 항목 정의 연결
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SLM 관리자는 고급 찾기 대화 상자에서 검색 기준을 지정하여 모든 ICMP 측
정 항목 정의를 검색하고 검색 결과 패널에서 이를 선택한 후 선택 버튼을 클
릭합니다.

그림 7-9 ICMP 측정 항목 정의 검색
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이제 선택한 측정 항목 정의가 검색 필터에 나열됩니다.

그림 7-10 검색 필터에 연결된 선택한 측정 항목 정의

같은 방식으로 SLM 관리자는 응답 시간을 측정하는 모든 OVIS 측정 항목 
정의를 포함하는 다른 검색 필터를 작성합니다.

그림 7-11 응답 시간 측정 항목의 검색 필터
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SLM 관리자는 추가 검색 필터를 측정 항목 어댑터로 연결하여(그림 7-12 
참조) 검색 절차의 범위를 넓힙니다. 검색 필터에 포함된 측정 항목 정의에 연
결된 모든 측정 항목은 측정 항목 검색이 트리거링될 때 발견됩니다.

그림 7-12 검색 필터 두 개가 모두 추가된 측정 항목 어댑터

이제 SLM 관리자는 명령 프롬프트에서 다음 명령을 실행하여 OVIS 측정 
항목 어댑터를 다시 시작합니다. 이로 인해 측정 항목 검색 절차가 트리거링됩
니다.

ovc -restart ovisma
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SLM 관리자는 OVIS 측정 항목 작업영역을 탐색하여 측정 항목 검색 절차가 
측정 항목 데이터 값의 소스를 나타내는 객체를 작성했는지 확인합니다.

그림 7-13 발견된 OVIS 측정 항목

측정 항목 정의보다 발견된 측정 항목 수가 적습니다. 이 차이는 측정 항목 
검색 필터의 어플리케이션 때문에 발생합니다.
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시나리오 2: 서비스 정의 디자인
이 시나리오는 서비스 수준 매니저에서 사용하기에 적합한 서비스 정의를 
작성하는 방법을 시연합니다. 190페이지의 "시나리오 3: 서비스 정의를 기반
으로 모니터링된 서비스 작성"은 이 서비스 정의를 기준으로 모니터링한 
서비스 작성을 시연합니다.

서비스 정의 계층 구축

서비스 디자이너는 서비스 정의 계층의 종속성을 고려하여 절차를 시작합니
다. 서비스 디자이너는 다음과 같은 질문을 고려합니다.

• 준수와 가용성을 위해 어떤 서비스 구성 요소를 모니터링해야 하는가?

• 서비스는 다른 부서 또는 조직에서 제공한 하위 서비스에 따라 좌우되는
가?

• 모든 구성 요소가 서로에게 어떻게 의존하는가?

이 시나리오에서 서비스 디자이너는 로드 균형이 조정된 웹 서버 프런트 엔드
가 있는 웹 서비스에 대한 서비스 정의를 디자인하고 후면 데이터베이스를 디
자인하며 하나 이상의 웹 서버를 포함하는 웹 서버를 디자인하려 합니다. 이 
예에서 데이터베이스 구성요소는 같은 조직 내 다른 부서에서 제공한 서비스
입니다.
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서비스 디자이너는 서비스 정의 작업영역에 액세스한 후 마우스 오른쪽 버튼
으로 뷰를 클릭하고 명령을 선택하여 서비스 정의 필터를 만듭니다. 

그림 7-14 서비스 정의 작성
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새 서비스 정의가 양식에서 열립니다. 설명과 같은 기본 세부사항을 양식에 입
력할 수 있지만 이 단계에서는 이름 지정만으로도 충분합니다. 서비스 디자이
너는 사용할 수 있는 모든 사용된 구성 요소에 필요한 가용성 전파 규칙도 선
택합니다.

그림 7-15 기본 서비스 정의 세부사항

서비스 디자이너가 새 서비스 정의를 저장하고 서비스 정의 계층 탭 페이지로 
전환하면 현재 서비스 정의 계층이 표시됩니다. 이 단계에서 계층은 서비스 정
의 자체로 구성됩니다. 서비스 디자이너는 이를 마우스 오른쪽 버튼으로 클릭
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하고 명령을 선택하여 로드 균형 조정 장치를 나타내는 구성 항목 정의를 추가
합니다.

그림 7-16 초기 서비스 정의 계층

다음 대화 상자가 표시됩니다.

그림 7-17 구성 항목 정의 관계 대화 상자

서비스 디자이너는 구성 항목 정의 필드 옆에 있는 빨리 찾기 버튼을 클릭합니
다. 사용할 수 있는 구성 항목 정의 목록이 표시된 빨리 찾기 대화 상자가 나타
납니다. 로드 균형 조정 장치 정의가 생성되지 않았으므로 서비스 디자이너는 
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객체 목록을 마우스 오른쪽 버튼으로 클릭한 후 명령을 선택하여 새 구성 항목 
정의를 작성합니다. 

그림 7-18 로드 균형 조정 장치 작성
7장162



SLM 시나리오
시나리오 2: 서비스 정의 디자인
서비스 디자이너는 로드 균형 조정 장치 정의의 기본 세부사항을 양식에 
제공한 후 정의를 저장합니다.

그림 7-19 기본 로드 균형 조정 장치 세부사항 지정

빨리 찾기 대화 상자에서 서비스 디자이너는 목록에서 로드 균형 조정 장치 정
의를 선택합니다.

그림 7-20 로드 균형 조정 장치 선택
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서비스 디자이너는 구성 항목 정의 관계 설정을 확인합니다.

그림 7-21 정의 관계 설정 확인

로드 균형 조정 장치 구성 항목 정의는 서비스 정의 계층에 자동으로 추가됩니
다.

그림 7-22 로드 균형 조정 장치를 포함한 서비스 정의 계층

웹 서버 팜을 나타내는 구성 항목 정의가 같은 방식으로 추가됩니다. 웹 서버 
팜에 대해 선택한 가용성 전파 규칙에는 사용할 수 있는 하나 이상의 사용된 
구성 요소(이 경우는 웹 서버)가 필요합니다. 

그림 7-23 웹 서버 팜 구성 항목 정의
7장164



SLM 시나리오
시나리오 2: 서비스 정의 디자인
이제 서비스 디자이너는 명령을 실행하여 웹 서버와 웹 서버 팜을 연결합니다.

그림 7-24 웹 서버 팜을 포함하는 계층

나타나는 대화 상자에서 서비스 디자이너는 1...* 범위를 선택합니다. 이는 이 
서비스 정의를 기반으로 하는 서비스 계층에 하나 이상의 웹 서버 구성 
항목이 있어야 하며 그 수에 제한이 없음을 나타냅니다. 대상 필드에서 필요
한 구성 항목 정의를 선택합니다. 서비스 디자이너는 사용 관계 유형을 선택
합니다. 

그림 7-25 사용된 구성 항목 정의로 웹 서버 추가
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다음 그림은 지금까지 작성된 서비스 정의 계층을 표시합니다.

그림 7-26 웹 서버가 추가된 서비스 정의 계층

마지막으로 서비스 디자이너는 명령을 실행하여 사용된 서비스 정의를 추가
하고 다른 부서에서 제공할 데이터베이스 서비스를 나타냅니다.

그림 7-27 사용된 서비스 정의 추가
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사용된 서비스 정의가 아직 없으므로 서비스 디자이너는 빨리 찾기 대화 상자
를 마우스 오른쪽 버튼으로 클릭한 후 명령을 선택하여 이를 작성합니다.

그림 7-28 사용된 서비스 정의 선택

서비스 정의를 지정된 기본 세부사항으로 저장하면 서비스 디자이너가 빨리 
찾기 대화 상자에서 이를 선택할 수 있습니다. 완료된 서비스 정의 계층은 다
음 그림에 표시됩니다.

그림 7-29 완료된 서비스 정의 계층
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측정 항목 정의 추가

이제 서비스 디자이너는 계층의 정의를 기준으로 어떻게 객체를 측정할 것인
지 고려합니다. 서비스 디자이너는 측정 항목 검색 절차에 따라 사용할 수 있
게 된 측정 항목 정의를 사용할 수 있습니다. 그 뿐 아니라, 서비스 디자이너는 
수동으로 작성한 OVSD 측정 항목 정의를 사용할 수 있습니다. 이 정의는 
MTBF(평균 고장 간격)를 포함한 서비스 성능의 다양한 측면을 측정하는 것입
니다.

로드 균형 조정 장치는 OVIS ICMP 가용성 측정 항목 정의에 따라 측정됩니다
. 서비스 디자이너는 계층에서 로드 균형 조정 장치 구성 항목 정의를 클릭하
고 편집할 명령을 선택합니다.

그림 7-30 로드 균형 조정 장치 편집
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구성 항목 정의 양식에서 서비스 디자이너는 측정 항목 정의가 기재된 탭 페이
지를 탐색한 후 새로 만들기 버튼을 클릭하여 새 구성 항목 측정 항목 정의를 
추가합니다.

그림 7-31 구성 항목 측정 항목 정의의 목록 표시

구성 항목 측정 항목 정의 양식에서 서비스 디자이너는 측정 항목 정의 필드 
옆에 있는 빨리 찾기 버튼을 클릭합니다.

그림 7-32 대화 상자를 열어 측정 항목 정의 선택

빨리 찾기 대화 상자가 열립니다. 객체 유형 필드에서 서비스 디자이너는 필요
한 측정 항목 정의 유형을 선택한 후 목록에서 OVIS ICMP 가용성 측정 항목 
정의를 선택합니다. 
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그림 7-33 가용성/ICMP 측정 항목 정의 선택

구성 항목 측정 항목 정의가 목록에 추가됩니다.

그림 7-34 양식에 추가된 가용성/ICMP 측정 항목 정의
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서비스 디자이너는 같은 절차를 반복하여 OVIS HTTP 가용성 측정 항목 
정의를 추가하고 웹 서버를 측정합니다. 

서비스 디자이너는 웹 서버 팜에 대한 측정 항목 정의를 추가하지 않기로 
선택합니다. 이 정의를 기반으로 한 구성 항목은 해당 가용성 전파 규칙에 
따라 계산된 가용성을 갖추게 되며, 이 규칙은 "적어도 하나의 하위 항목 사용 
가능"으로 설정됩니다(그림 7-23 참조). 웹 서버 하나를 사용할 수 있는 한 웹 
서버 팜도 사용할 수 있는 것으로 계산됩니다.

서비스 계층의 시각적 지원은 웹 서버 팜과 상관 없이 모든 구성 항목 정의에 
측정 항목 정의가 추가되었는지 확인합니다. 

그림 7-35 측정 항목 정의가 추가된 정의 계층

다음 단계에서는 서비스 정의 자체를 어떻게 측정해야 하는지 정의합니다. 
인프라 가용성 측정 항목 정의는 서비스 정의 작성 절차의 일부분으로 자동 추
가됩니다. 
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그림 7-36 서비스 측정 항목 정의의 목록 표시

서비스 디자이너는 OVIS HTTP 응답 시간 측정 항목 정의를 자동으로 사용할 
것인지 결정합니다. 이는 구성 항목 측정 항목 정의와 같은 방식으로 추가됩니
다. 
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서비스 디자이너는 평균 고장 간격을 측정하는 서비스 데스크 측정 항목을 
사용할 것인지도 결정하고 새로 만들기 버튼을 클릭하여 양식에서 새 서비스 
측정 항목 정의를 엽니다.

그림 7-37 OVSD 서비스 측정 항목 정의 추가
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서비스 측정 항목 정의 양식에서 서비스 디자이너는 측정 항목 정의 필드 
옆에 있는 빨리 찾기 버튼을 클릭합니다. 

그림 7-38 대화 상자를 열어 측정 항목 정의 선택

빨리 찾기 대화 상자가 열립니다. 객체 유형 필드에서 서비스 디자이너는 
사용할 측정 항목 정의의 유형을 선택합니다. 현재 정의된 서비스 데스크 
측정 항목 정의가 없으므로 서비스 디자이너는 객체 패널을 마우스 오른쪽 
버튼으로 클릭하고 명령을 선택하여 새 정의를 작성합니다.
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그림 7-39 MTBF 측정 항목 정의 작성
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새 OVSD 측정 항목 정의가 양식에서 열립니다. 서비스 디자이너는 이름을 제
공하고 평균 고장 간격을 측정 항목 유형으로 선택하며 측정 유형의 기본을 정
의하는 다른 옵션을 선택합니다.

그림 7-40 OVSD 측정 항목 정의 양식

서비스 디자이너가 측정 항목 정의를 저장하고 양식을 닫으면 빨리 찾기 
대화 상자에 표시된 목록에서 이를 선택할 수 있습니다. 

그림 7-41 MTBF 측정 항목 정의 선택
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선택한 서비스 측정 항목 정의가 목록에 나타납니다. 그림 7-42에는 세 가지 서
비스 측정 항목 정의가 표시되어 있습니다.

그림 7-42 목록에 추가된 OVSD 서비스 측정 항목 정의
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이 단계에서 서비스 정의 계층은 구축되지만 측정 항목 정의는 웹 서버 팜과 별
도로 계층을 통해 지정됩니다(168페이지의 "측정 항목 정의 추가" 설명 참조).

그림 7-43 측정 항목 정의로 완료된 계층

서비스 수준 추가

고객의 다양한 서비스 품질에 대한 기대를 만족시키기 위해 서비스 디자이너
는 골드, 실버, 브론즈 등 세 가지 다양한 서비스 수준으로 웹 서비스를 제공하
기로 합니다.

서비스 디자이너는 서비스 정의와 연관된 서비스 수준이 기재된 탭 페이지를 
탐색하고 새로 만들기 버튼을 클릭합니다.
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그림 7-44 서비스 수준 추가

서비스 수준 양식에서 서비스 정의 필드는 관련 서비스 정의로 자동으로 채워
집니다. 서비스 디자이너는 서비스 수준에 대한 이름을 제공하고 이를 저장합
니다.

그림 7-45 기본 서비스 수준 세부사항 제공
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서비스 디자이너는 각 서비스 수준별 작업을 차례로 반복합니다. 그림 7-46은 
서비스 정의와 연관된 서비스 수준을 보여줍니다.

그림 7-46 서비스 수준

가용성 목표 추가

이제 서비스 디자이너는 어떤 가용성 목표를 추가할 것인지 결정합니다. 처음
에는 가용성 SLO 테이블에 빈 목표 테이블이 표시됩니다. 이 테이블에는 추가
된 각 서비스 수준에 대한 열(178페이지의 "서비스 수준 추가" 참조)과 각 구성 
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항목 측정 항목 정의에 대한 행(168페이지의 "측정 항목 정의 추가" 참조)이 포
함됩니다. 측정 항목 정의는 구성 항목 정의 밑에 그룹화되어 있습니다.

그림 7-47 가용성 SLO 테이블

OVIS ICMP 및 HTTP 가용성 측정 항목은 값 0 또는 1을 반환하므로 서비스 디
자이너는 "보다 크거나 같음"이라는 연산자와 각 측정 항목 정의에 값 1을 지
정하기로 결정합니다. "보다 큼" 연산자와 값 0.5를 선택해도 같은 효과가 있을 
수 있습니다. 

• 측정 항목 데이터 값 1을 수신하면 목표가 달성됩니다.

• 측정 항목 데이터 값 0을 수신하면 목표가 달성되지 않습니다.
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서비스 디자이너는 연산자 열의 드롭다운 목록에서 필요한 연산자를 선택합
니다. 

그림 7-48 가용성 객체 연산자 선택

서비스 디자이너는 각 테이블 셀에 목표 값을 입력합니다.

그림 7-49 목표 값 지정

다음 그림은 모든 연산자와 값이 추가된 테이블을 보여줍니다. 

그림 7-50 완료된 가용성 SLO 테이블
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준수 목표 추가

이제 서비스 디자이너는 준수 목표를 지정하기 시작합니다. 서비스 수준별로 
서로 다른 준수 기준을 지정할 수 있습니다. 측정 항목 및 서비스 수준의 특정 
조합에 대한 테이블 셀이 비어 있으면 측정 항목이 준수 계산에서 제외됩니다
. 서비스 디자이너는 웹 서비스 정의에 대한 다음 준수 계산 계획을 선택합니
다.

• 골드 서비스 수준으로 제공된 서비스는 세 가지 측정 항목 목표(인프라 
가용성, OVIS HTTP 응답 시간, OVSD MTBF)를 모두 만족시켜야 
합니다.

• 실버 서비스 수준으로 제공된 서비스는 인프라 가용성 및 OVIS HTTP 응
답 시간 측정 항목 목표를 만족시켜야 합니다. OVSD MTBF 측정 항목은 
준수 계산에서 무시됩니다.

• 브론즈 서비스 수준으로 제공된 서비스는 인프라 가용성 측정 항목 목표
를 만족시켜야 합니다. OVIS HTTP 응답 시간 측정 항목 및 OVSD MTBF 
측정 항목은 준수 계산에서 무시됩니다.

처음에는 준수 SLO 탭 페이지에 자동 생성된 인프라 가용성 측정 항목에 대해 
사전 정의된 준수 목표 임계치가 표시됩니다. OVIS HTTP 응답 시간 및 OVSD 
MTBF 측정 항목에 대한 목표 연산자와 값은 지정해야 합니다. 

서비스 디자이너는 연산자 열의 드롭다운 목록에서 연산자를 선택합니다. 
OVIS HTTP 응답 시간 측정 항목의 경우에는 "보다 작거나 같음" 연산자가 적
합합니다. 이는 측정된 응답 시간이 목표 임계치 값보다 작을 때 목표 상태가 
달성된다는 뜻입니다.
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그림 7-51 준수 목표 연산자 선택

OVSD MTBF 측정 항목의 경우에는 "보다 크거나 같음" 연산자가 적합합니다
. 이는 측정된 평균 고장 간격이 목표 임계치 값보다 클 때 목표 상태가 달성된
다는 뜻입니다. 

서비스 디자이너는 각 테이블 셀에 목표 임계치 값을 직접 입력합니다. 서비스 
수준별로 서로 다른 값을 지정합니다.
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그림 7-52 준수 목표 값 입력

이제 서비스 디자이너는 준수 위반 임계치를 지정합니다. 

인프라와 표준 측정 항목 정의의 경우 준수 위반 임계치는 (평가 기간 동안의 
총 서비스 시간과 비교하여) 객체 상태가 달성할 최소 시간 퍼센트를 지정합니
다. 퍼센트 임계치가 위반되면 목표의 준수 상태가 위반됩니다. 

OVSD MTBF와 같이 집계된 측정 항목 정의의 경우 위반 임계치는 목표 상태 
임계치와 동일하며 연산자는 반대로 바뀝니다. 예를 들어, OVSD MTBF 목표 
값이 80시간이고 연산자가 "보다 큼"인 경우 위반 임계치 값은 80으로 자동 설
정되며, 연산자는 "보다 작음"으로 자동 설정됩니다. 반대로 OVSD MTBF 목
표 값이 2시간이고 연산자가 "보다 작음"인 경우 위반 임계치 값은 2로 자동 설
정되며 연산자는 "보다 큼"으로 자동 설정됩니다.
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서비스 디자이너는 골드 서비스 수준에 대한 인프라 가용성 측정 항목으로 
시작한 후 준수 임계치 테이블에서 해당 셀을 더블 클릭합니다.

그림 7-53 준수 임계치 양식 액세스

준수 서비스 수준 목표 양식이 열립니다. 준수 임계치를 지정하려면, 서비스 
디자이너는 임계치 목록에서 새로 만들기 버튼을 클릭합니다.

그림 7-54 준수 위반 임계치 추가

준수 임계치 양식이 열립니다. 서비스 디자이너는 준수 위반 임계치가 지정될 
때까지 위험 임계치를 지정할 수 없습니다. 서비스 디자이너는 95%로 값을 지
정합니다.
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그림 7-55 위반 임계치 값 입력

서비스 디자이너는 위험 임계치 값을 98%로 지정하기로 결정하고 심각도를 
"경고"로 선택합니다. 위험 임계치는 서로 다른 퍼센트 값과 심각도 코드에 
따라 추가로 지정할 수 있습니다.

그림 7-56 위험 임계치 값 입력

그림 7-57에는 완료된 준수 서비스 수준 목표 양식이 표시됩니다. 평가 기간 동
안 가용성 목표가 2% 서비스 시간에 도달하지 못하면 인프라 가용성 목표의 
준수 상태가 위험으로 떨어집니다. 이 목표가 5% 서비스 시간에 도달하지 못
하면 인프라 가용성 목표가 위반됩니다. 이는 서비스 준수 상태가 위반되는 충
분한 원인이 될 수 있습니다.
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그림 7-57 완료된 준수 서비스 수준 목표 양식

위반 및 위험 임계치 지정 절차는 각 측정 항목과 서비스 수준 조합별로 반복
되며 측정 항목은 준수 계산에 영향을 미칩니다. 183페이지의 "준수 목표 추가
" 절의 첫 부분에 있는 준수 계산 계획에 대한 설명을 참조하십시오.
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그림 7-58 완료된 준수 SLO 테이블

서비스 디자이너는 서비스 정의를 저장하고 닫습니다. 이제 서비스 관리자는 
이를 사용하여 모니터링된 서비스를 작성할 수 있습니다(190페이지의 "시나
리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성" 참조). 
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시나리오 3: 서비스 정의를 기반으로 모니터링된 
서비스 작성
이 시나리오는 158페이지의 "시나리오 2: 서비스 정의 디자인"에서 작성한 웹 
페이지에 대한 서비스 정의를 기반으로 하는 모니터링 서비스를 서비스 관리
자가 어떻게 만드는지 설명합니다. 

SLA 세부사항 지정

서비스 관리자는 사용된 데이터베이스 서비스에 대한 새 서비스 수준 계약을 
작성하여 시작합니다.

그림 7-59 사용된 서비스에 대한 새 서비스 수준 계약 작성
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서비스 관리자는 데이터베이스 서비스에 대한 서비스 정의를 선택하고 골드 
서비스 수준을 선택합니다.

그림 7-60 기본 SLA 세부사항
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서비스 관리자는 관련 서비스 목록을 탐색하고 새로 만들기 버튼을 클릭하여 
새 서비스를 작성합니다.

그림 7-61 새 데이터베이스 서비스 작성
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서비스 관리자는 서비스 양식에서 기본 세부사항을 지정합니다.

그림 7-62 기본 서비스 세부사항
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서비스가 저장되면 관련 서비스 목록에 자동으로 추가됩니다.

그림 7-63 SLA에 기재된 데이터베이스 서비스
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이제 서비스 관리자는 웹 서비스 정의를 기반으로 웹 서비스에 대한 새 서비스 
수준 계약을 작성합니다. 고객은 웹 서비스 골드 서비스 수준에 관심이 있습니
다.

그림 7-64 웹 서비스를 위한 SLA
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고객에게 제공될 웹 서비스는 작성된 후 SLA와 동일한 서비스 정의에 연결됩
니다.

그림 7-65 웹 서비스 기본 세부사항

이제 서비스 관리자는 서비스 또는 구성 항목을 갖춘 계층에서 각 정의를 
교체하는 절차를 시작합니다.
7장196



SLM 시나리오
시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
정의 교체

처음에는 서비스 계층에 서비스 정의 계층에서 계승한 정의가 표시됩니다. 
짙은 붉은색 선으로 연결된 각 정의는 서비스 또는 구성 항목과 교체되어야 합
니다.

그림 7-66 초기 서비스 계층
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
서비스 관리자는 서비스와 데이터 서비스 정의를 연결하는 선을 마우스 오른
쪽 버튼으로 클릭하고 서비스와 연결할 명령을 선택합니다.

그림 7-67 데이터베이스 서비스 정의 교체

빨리 찾기 대화 상자에서 서비스 관리자는 서비스 정의를 교체할 서비스를 
선택합니다.

그림 7-68 데이터베이스 서비스 선택
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SLM 시나리오
시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
서비스 계층은 데이터베이스 서비스 정의 대신 데이터베이스 서비스를 자동
으로 표시하며 커넥터 선은 붉은색에서 검정색으로 변합니다.

그림 7-69 계층에 표시된 데이터베이스 서비스

서비스 관리자는 서비스와 로드 균형 조정 장치 구성 항목 정의를 연결하는 
선을 마우스 오른쪽 버튼으로 클릭하고 구성 항목과 연결할 명령을 선택합
니다.

그림 7-70 로드 균형 조정 장치 구성 항목 정의 교체
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
빨리 찾기 대화 상자에는 현재 존재하는 로드 균형 조정 정의를 기반으로 
하는 구성 항목이 없음을 나타내는 빈 목록이 표시됩니다. 서비스 관리자는 대
화 상자를 마우스 오른쪽 버튼으로 클릭하고 명령을 선택하여 새 구성 항목을 
작성합니다.

그림 7-71 로드 균형 조정 장치 구성 항목 작성
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
구성 항목 양식에서 서비스 관리자는 구성 항목에 대한 기본 세부사항을 
제공하고 정확한 정의와 이를 연결한 후 저장합니다.

그림 7-72 로드 균형 조정 장치 기본 세부사항
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
빨리 찾기 대화 상자에서 서비스 관리자는 새로 작성한 구성 항목을 선택
합니다.

그림 7-73 로드 균형 조정 장치 구성 항목 정의 선택

서비스 계층은 정의 대신 구성 항목을 자동으로 표시합니다.

그림 7-74 계층에 표시된 구성 항목
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
서비스 관리자는 같은 방식으로 웹 서버 팜 정의와 구성 항목을 교체합니다.

그림 7-75 계층에 표시된 웹 서버 팜 CI

서비스 관리자가 웹 서버 구성 항목 정의를 교체하면 이 정의에 대한 아이콘이 
계층에 남아 있습니다. 이 표시기는 1...*에서 0...*로 변하며, 짙은 붉은색 선은 
검정색 점선으로 교체됩니다. 이는 웹 서버 정의를 추가 구성 항목으로 교체할 
수는 있지만 교체할 필요는 없음을 나타냅니다. 이 예에서 서비스 
관리자는 웹 서버를 추가하지 않기로 결정합니다. 이제 정의는 서비스 및 
구성 항목으로 모두 교체됩니다. 

그림 7-76 웹 서버 구성 항목 하나를 포함하는 계층
7장 203



SLM 시나리오
시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
측정 항목 소스 지정

이제 서비스 관리자는 측정 항목 데이터 값의 소스를 정의하는 측정 항목을 지
정할 준비를 마쳤습니다. 이는 각 서비스 측정 항목과 서비스 계층의 각 
구성 항목 측정 항목에 대해 실시해야 합니다(자동 생성된 인프라 가용성 
측정 항목 제외).

일반적으로 OVIS, OVPM, OVSN 측정 항목은 측정 항목 검색에 따라 사용할 
수 있습니다(146페이지의 "시나리오 1: 측정 항목 구성 및 검색" 참조). 
일반적으로 OVSD 측정 항목은 수동으로 작성됩니다.

서비스 측정 항목에 대한 측정 항목 소스를 지정하기 위해 서비스 관리자는 준
수 SLO 테이블을 표시하는 탭 페이지를 탐색합니다. 서비스 관리자는 OVIS 
HTTP 응답 시간 측정 항목 이름을 더블 클릭합니다.

그림 7-77 서비스 측정 항목에 대한 측정 항목 소스 목록 액세스
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
서비스 관리자는 목록에 표시된 측정 항목에서 선택합니다. 측정 항목은 측정 
항목 검색 결과에 따라 선택할 수 있습니다(146페이지의 "시나리오 1: 측정 항
목 구성 및 검색" 참조).

그림 7-78 목록에서 측정 항목 데이터 소스 선택

측정 항목 임계치 테이블에 대한 시각적 지원은 OVIS HTTP 응답 시간 측정 항
목이 구성되었는지 표시하기 위해 업데이트되지만 OVSD MTBF 측정 
항목은 여전히 구성해야 합니다.

그림 7-79 업데이트된 측정 항목 임계치 테이블
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
OVSD MTBF 측정 항목을 구성하기 전에 MTBF 데이터 수집 및 계산을 구성
해야 합니다. 서비스 관리자는 양식에서 서비스 수준 계약을 열고 서비스 데스
크 측정 항목을 기재한 탭 페이지를 검색하며 새로 만들기 버튼을 클릭
하여 새 측정 항목을 작성합니다.

그림 7-80 SLA의 서비스 데스크 측정 항목

OVSD 측정 항목 양식이 열립니다. 서비스 관리자는 서비스 정의 작성 절차에
서 작성된 MTBF 측정 항목 정의로 측정 항목을 연결하고(158페이지의 "시나
리오 2: 서비스 정의 디자인" 참조) 이름과 같은 기본 세부사항을 제공합니다. 
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
선택한 일일 순환 일정은 매일 수집되어 계산되는 MTBF 데이터를 지정합니다
. 각 수집은 평가 기간이 시작되는 순간부터 누적됩니다.

그림 7-81 OVSD 측정 항목 수집 세부사항 지정
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
작성된 측정 항목은 서비스 수준 계약의 서비스 데스크 측정 항목 목록에 
추가됩니다.

그림 7-82 SLA에 기재된 OVSD 측정 항목

이제 서비스 관리자는 OVSD MTBF 측정 항목 소스를 구성할 수 있습니다. 서
비스 양식의 측정 항목 임계치 테이블로 돌아가면 서비스 관리자는 측정 
항목 이름을 더블 클릭합니다.
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
그림 7-83 OVSD MTBF 측정 항목 소스 지정

서비스 관리자는 목록에서 OVSD 측정 항목을 선택합니다.

그림 7-84 OVSD MTBF 측정 항목 선택
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
측정 항목 임계치 테이블의 시각적 지원은 모든 측정 항목이 구성되었는지 
표시하기 위해 업데이트됩니다.

그림 7-85 완료된 준수 SLO 테이블
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
구성 항목 측정 항목에 대한 측정 항목 소스를 지정하기 위해 서비스 관리자는 
가용성 SLO를 표시하는 탭 페이지를 먼저 탐색한 후 측정 항목 이름을 
더블 클릭합니다.

그림 7-86 구성 항목 측정 항목에 대한 소스 목록 액세스
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
서비스 관리자는 목록에 표시된 측정 항목에서 선택합니다.

그림 7-87 목록에서 측정 항목 데이터 소스 선택

가용성 SLO 테이블의 시각적 지원은 로드 균형 조정 장치에 대한 가용성 
측정 항목이 구성되었는지 표시하기 위해 자동으로 업데이트됩니다.

그림 7-88 업데이트된 가용성 목표 테이블
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
서비스 관리자는 다른 가용성 목표에 대해 이 절차를 반복합니다.

그림 7-89 완료된 가용성 목표 테이블

서비스 계층에 대한 시각적 지원은 계층의 모든 객체가 해당 정의를 준수하며 
모든 측정 항목이 완전히 구성되었는지 확인합니다.

그림 7-90 완전히 구성된 계층
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
서비스 수준 계약 관리

이 시나리오의 마지막 단계는 SLM 계약하에 서비스 수준 계약을 놓는 것입니
다. 서비스 양식에서 서비스 관리자는 라이프 사이클, 관리, 활동, 계층 상태 필
드에서 적절한 값을 선택합니다.

그림 7-91 서비스 관리
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
서비스 수준 계약의 라이프 사이클 상태는 "관리됨" 관리 상태로 매핑하는 
값으로 업데이트되어야 합니다.

그림 7-92 서비스 수준 계약 관리
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시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성
서비스 관리자는 서비스 상태 작업영역을 탐색합니다. 모니터링된 서비스가 
목록에 자동으로 추가되었습니다. 이로써 서비스가 SLM 관리하에 있음을 
확인합니다. SLA 시작 날짜가 되자마자 준수 및 가용성 계산이 자동으로 
시작됩니다.

그림 7-93 관리된 서비스 상태 보기
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시나리오 4: 계층 필터 작성
시나리오 4: 계층 필터 작성
이 시나리오는 계층 필터 작성을 시연합니다. 233페이지의 "시나리오 5: 계층 
필터를 기반으로 서비스 작성"은 계층 필터를 모니터링된 서비스 작성으로 시
연합니다. 두 시나리오에서 모두 관련 서비스와 구성 항목이 있는 CMDB가 있
는 것으로 가정합니다.

기본 계층 필터 세부사항 입력

서비스 디자이너는 계층 필터 작업영역에 액세스한 후 마우스 오른쪽 버튼으
로 뷰를 클릭하고 명령을 선택하여 새 계층 필터를 만듭니다. 

그림 7-94 새 계층 필터 작성
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시나리오 4: 계층 필터 작성
양식에서 서비스 디자이너는 계층 최상단 객체 유형을 먼저 지정해야 합니다. 
이 시나리오에서 계층에는 루트 객체로 서비스가 있어야 합니다. 서비스 디자
이너는 루트 객체 필드 옆에 있는 빨리 찾기 버튼을 클릭하고 객체 목록에서 서
비스를 선택합니다.

그림 7-95 루트 객체 유형 지정
7장218



SLM 시나리오
시나리오 4: 계층 필터 작성
서비스 디자이너는 필터 이름과 같은 추가 기본 세부사항을 지정합니다. 
루트 객체 미리보기 필드에서 서비스 디자이너는 고객에게 제공될 서비스를 
선택합니다. 현재 지정된 필터 규칙이 없기 때문에 서비스 자체 이외의 미리보
기 패널에서 검색되거나 표시된 객체가 없습니다.

그림 7-96 기본 계층 필터 세부사항 입력
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시나리오 4: 계층 필터 작성
필터 규칙 목록 작성

서비스 디자이너가 추가 필터 규칙을 시작할 준비를 마쳤습니다. 첫 번째 
규칙이 사용된 모든 서비스를 검색하게 됩니다. 서비스 디자이너는 필터 규칙 
아래에 있는 새로 만들기 버튼을 클릭하여 계층 필터 규칙 대화 상자에 액세스
한 후 시작 객체 유형 필드 옆에 있는 빨리 찾기 버튼을 클릭합니다.

그림 7-97 '시작' 객체 유형 검색
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서비스 디자이너는 목록에서 서비스를 선택합니다.

그림 7-98 '시작' 객체 유형으로 서비스 선택

이 단계에서 서비스는 옵션일 뿐입니다. 다른 객체 유형을 검색하는 필터 
규칙이 추가되면 이러한 객체 유형으로 목록이 확장됩니다.
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이제 서비스 디자이너는 연결 속성 필드 옆에 있는 빨리 찾기 버튼을 클릭합니
다. 빨리 찾기 대화 상자에서 서비스 디자이너는 사용 서비스 연결 속성을 선
택합니다.

그림 7-99 연결 속성으로 사용된 서비스 선택

계층 필터 규칙 대화 상자의 내용을 확인한 후 서비스 디자이너는 확인을 
클릭합니다. 

그림 7-100 사용된 서비스의 필터 규칙 확인
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필터 규칙은 계층 필터 양식에서 목록에 추가되며 규칙으로 검색한 사용된 
서비스는 미리보기 패널에 자동으로 표시됩니다.

그림 7-101 필터 규칙으로 검색한 사용된 서비스

추가될 다음 필터 규칙이 사용된 구성 항목을 검색하게 됩니다. 서비스가 
다시 한 번 '시작' 객체 유형으로 선택되며 사용된 CI가 연결 속성으로 선택
됩니다.

그림 7-102 사용된 구성 항목의 필터 규칙 확인
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필터 규칙은 계층 필터 양식에서 목록에 추가되며 규칙으로 검색한 사용된 
구성 항목은 미리보기 패널에 자동으로 표시됩니다.

그림 7-103 필터 규칙으로 검색한 사용된 서비스 및 CI
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추가될 다음 필터 규칙이 '사용' 관계 유형으로 관련 구성 항목을 검색하게 
됩니다. 이 때, 서비스가 다시 한 번 '시작' 객체 유형으로 선택되며 관련 CI가 
연결 속성으로 선택됩니다.

그림 7-104 '시작' 객체 유형으로 관련 구성 항목 선택

계층 필터 규칙 대화 상자의 내용을 확인한 후 서비스 디자이너는 확인을 
클릭합니다. 

그림 7-105 관련 CI를 검색할 필터 규칙 확인
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필터 규칙은 계층 필터 양식에서 목록에 추가되며, 규칙으로 검색한 관련 
구성 항목은 미리보기 패널에 자동으로 표시됩니다. 연결 유형이 지정되지 
않았기 때문에 (여기에서 연결 유형은 '구성 항목 연결 유형'을 말함) 모든 
관련 구성 항목이 검색됩니다. 

두 방향에서 관련 구성 항목을 구성하는 라인은 역 관계 유형이 있는 각 관계 
유형의 양방향을 가리킵니다. 상황을 명확히 하기 위해 서비스 디자이너는 필
터 규칙을 편집하여 연결 유형을 지정합니다. 

필터 규칙으로 검색한 관련 구성 항목

먼저, 서비스 디자이너는 편집할 규칙을 강조하고 편집 버튼을 클릭합니다. 계
층 필터 규칙 대화 상자에서 서비스 디자이너는 연결 유형 필드 옆에 있는 빨
리 찾기 버튼을 클릭합니다. 
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열린 대화 상자에서 서비스 디자이너는 객체 유형으로 CI 관계를 선택
합니다.

그림 7-106 연결 유형에 대한 CI 관계 선택

이제 서비스 디자이너는 구성 항목 관계 사용 유형을 선택합니다.
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그림 7-107 '사용' 연결 유형 선택

계층 필터 규칙 대화 상자의 수정된 내용을 확인한 후 서비스 디자이너는 
확인을 클릭합니다. 

그림 7-108 관련 CI에 대한 필터 규칙 변경사항 확인

미리보기 패널이 사용 유형의 구성 항목 관계만을 표시하도록 자동으로 
업데이트됩니다.
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그림 7-109 편집된 필터 규칙으로 검색한 관련 CI

이제 서비스 디자이너는 필터 규칙을 추가하여 실행 관계 유형을 갖춘 구성 항
목을 검색합니다. 
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그림 7-110 검색된 '실행' CI 관계를 갖춘 계층

이 시나리오에서 서비스 관리자는 HP/UX 인프라를 나타내는 구성 항목을 
제외하려고 하지만 Windows 2000 인프라를 나타내는 구성 항목은 포함하
려고 합니다. 
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각 구성 항목이 범주에 할당되어 있으므로 서비스 디자이너는 필터 규칙의
'대상' 범주를 지정하여 계층 필터에 필요한 수정을 실시할 수 있습니다.

그림 7-111 '대상' 범주로 'WinInfra' 선택

계층 필터 규칙 대화 상자의 수정된 내용을 확인한 후 서비스 디자이너는 
확인을 클릭합니다. 

그림 7-112 '대상' 범주로 필터 규칙 확인
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미리보기 패널은 HP/UX 인프라를 나타내는 구성 항목을 제거하기 위해 자동
으로 업데이트됩니다.

그림 7-113 완료된 계층 필터

서비스 디자이너는 계층 필터를 저장하고 닫습니다. 이제 서비스 관리자는 
이를 사용하여 모니터링된 서비스를 작성할 수 있습니다. 
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시나리오 5: 계층 필터를 기반으로 서비스 작성
이 시나리오는 217페이지의 "시나리오 4: 계층 필터 작성"에서 작성한 계층 필
터를 기반으로 서비스 계층을 작성하는 방법을 시연합니다. 이 시나리오에서
는 관련 서비스와 구성 항목이 있는 CMDB가 있는 것으로 가정합니다.

SLA 세부사항 지정

서비스 관리자는 새 SAP 네트워크 서비스를 작성하고 사용된 SAP 네트워크 
서비스에 대한 서비스 수준 계약을 작성하여 시작합니다. 이 절차는 190페이
지의 "시나리오 3: 서비스 정의를 기반으로 모니터링된 서비스 작성"에서 웹 
서비스를 사용하여 데이터베이스 서비스에 대한 서비스 및 SLA를 작성하는 
절차와 유사합니다.

이제 서비스 관리자는 SAP R/3 계층 필터를 기반으로 할 SAP R/3의 새 SLA를 
작성합니다.

그림 7-114 사용된 서비스에 대한 서비스 수준 계약 작성
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서비스 관리자는 서비스 수준 필드 옆에 있는 빨리 찾기 버튼을 클릭하고 
빨리 찾기 대화 상자를 마우스 오른쪽 버튼으로 클릭한 후 명령을 선택하여 새 
서비스 수준을 만듭니다.

그림 7-115 SLA에 새 서비스 수준 연결

새 서비스 수준이 양식에서 열립니다. 서비스 관리자는 기본 세부사항을 
지정합니다.
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그림 7-116 새 서비스 수준에 대한 기본 세부사항 지정 

서비스 관리자는 새 서비스 수준을 저장한 후 빨리 찾기 대화 상자에서 이를 
선택합니다.

그림 7-117 새 서비스 수준 선택
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서비스 관리자는 SAP/R3 서비스를 위한 서비스 수준 계약에서 기본 세부사항
을 계속 지정합니다.

그림 7-118 SAP/R3 서비스를 위한 SLA

서비스 관리자는 관련 서비스 목록 밑에 있는 새로 만들기 버튼을 클릭합니다.
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그림 7-119 SAP/R3 SLA로 새 시나리오 연결

새 서비스가 양식에서 열립니다. 서비스 관리자는 동일한 계층 필터를 서비스 
수준 계약에 연결할 때와 같이 서비스 계층 필터로 연결한 후 새 서비스를 저
장합니다. 서비스 관리자가 서비스 계층 탭 페이지를 탐색하는 즉시 필터에서 
계승한 계층이 나타납니다.
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그림 7-120 계층 필터에서 계승한 서비스 계층

계층에 서비스 측정 항목 추가

이제 서비스 관리자는 준수를 위해 어떻게 서비스를 측정할 것인지 고려합니
다. 인프라 가용성 측정 항목은 서비스를 작성할 때 자동으로 추가됩니다. 서
비스 관리자는 SAP 응답 유형의 추가 OVIS 측정 항목을 추가할 것인지 결정
하므로 서비스 측정 항목 목록 아래 있는 새로 만들기 버튼을 클릭합니다. 
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그림 7-121 서비스에 새 서비스 측정 항목 추가

서비스 측정 항목 양식에서 서비스 관리자는 측정 항목 필드 옆에 있는 빨리 
찾기 버튼을 클릭합니다.

그림 7-122 측정 항목 검색
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빨리 찾기 대화 상자가 열립니다. 서비스 관리자는 객체 유형 필드에서 필요한 
측정 항목 유형을 선택한 후 측정 항목을 선택하여 SAP 응답 시간을 목록에서 
측정합니다. 각 측정 항목은 측정 유형뿐 아니라 측정 데이터 값 소스도 지정
합니다.

그림 7-123 측정 항목 선택

선택한 서비스 측정 항목이 목록에 추가됩니다. 
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그림 7-124 목록에 추가된 새 서비스 측정 항목

계층에 구성 항목 측정 항목 추가

이제 서비스 관리자는 계층의 각 구성 항목을 어떻게 측정할지 고려합니다. 측
정 항목 검색 절차의 결과로 사용 가능한 측정 항목은 사용할 수 있습니다.

서비스 관리자는 OVIS ICMP 가용성 프로브를 통해 SAP 로드 균형 조정 장치
를 측정하기로 결정합니다. 서비스 관리자는 계층에서 SAP 로드 균형 조정 장
치 구성 항목을 클릭하고 편집할 명령을 선택합니다. 이 구성 항목 양식에서 
서비스 관리자는 측정 항목이 있는 탭 페이지를 탐색하고 새로 만들기 버튼을 
클릭합니다.
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그림 7-125 새 구성 항목 측정 항목 추가

구성 항목 측정 항목 양식에서 서비스 관리자는 측정 항목 필드 옆에 있는 
빨리 찾기 버튼을 클릭합니다.
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그림 7-126 측정 항목 검색

서비스 관리자는 열려 있는 대화 상자에서 필요한 측정 항목 유형을 선택
합니다.

그림 7-127 측정 항목 유형 선택

빨리 찾기 대화 상자에서 서비스 관리자는 필요한 측정 항목을 선택하여 
가용성을 측정합니다. 각 측정 항목은 측정 유형뿐 아니라 측정 데이터 값 
소스도 지정합니다. 
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그림 7-128 구성 항목에 대한 측정 항목 선택

선택한 측정 항목은 구성 항목 측정 항목 양식에 나타납니다. 구성 항목 측정 
항목은 선택한 측정 항목을 기준으로 이름이 주어집니다.

그림 7-129 구성 항목 측정 항목 양식의 선택한 측정 항목
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SLM 시나리오
시나리오 5: 계층 필터를 기반으로 서비스 작성
서비스 관리자가 양식을 닫으면 구성 항목 측정 항목이 구성 항목 양식의 
목록에 추가됩니다.

그림 7-130 목록에 추가된 선택한 구성 항목 측정 항목

서비스 관리자는 이 절차를 반복하여 Win2k 구성 항목에 구성 항목 측정 
항목을 추가합니다.
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SLM 시나리오
시나리오 5: 계층 필터를 기반으로 서비스 작성
그림 7-131 Win2k CI에 추가된 구성 항목 측정 항목

계층에 준수 목표 추가

이제 서비스 관리자는 어떤 준수 목표를 추가할 것인지 결정합니다. 자동으로 
생성된 인프라 가용성 측정 항목에는 준수 목표 임계치에 대한 연산자와 사전 
정의된 값이 있습니다.
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SLM 시나리오
시나리오 5: 계층 필터를 기반으로 서비스 작성
그림 7-132 준수 SLO 테이블

SAP 응답 시간을 측정하는 측정 항목의 경우 서비스 관리자는 연산자 열의 드
롭다운 목록에서 목표 연산자를 선택합니다.
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SLM 시나리오
시나리오 5: 계층 필터를 기반으로 서비스 작성
그림 7-133 준수 목표 임계치 연산자 지정

서비스 관리자는 테이블 셀에 목표 값을 직접 입력합니다.
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SLM 시나리오
시나리오 5: 계층 필터를 기반으로 서비스 작성
그림 7-134 준수 목표 임계치 값 지정

이제 서비스 관리자는 SAP 응답 시간을 측정하는 측정 항목으로 시작하는 
준수 위반 임계치와 준수 위험 임계치를 지정합니다. 서비스 디자이너는 준수 
임계치 테이블에서 해당 셀을 더블 클릭합니다.
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SLM 시나리오
시나리오 5: 계층 필터를 기반으로 서비스 작성
그림 7-135 새 준수 위반 임계치 추가

서비스 관리자는 준수 위반 임계치의 이름을 제공하고 기본 위반 임계치 값을 
95%로 바꾸지 않고 둘 것인지 결정합니다.
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SLM 시나리오
시나리오 5: 계층 필터를 기반으로 서비스 작성
그림 7-136 준수 위반 임계치에 대한 기본 세부사항 지정

서비스 관리자가 양식을 저장하고 닫으면 위반 임계치 정보가 준수 임계치 
테이블에 표시됩니다. 다음 그림은 완료된 준수 임계치 테이블을 보여줍니다.
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SLM 시나리오
시나리오 5: 계층 필터를 기반으로 서비스 작성
그림 7-137 완료된 준수 임계치 테이블

계층에 가용성 목표 추가

이제 서비스 관리자는 어떤 가용성 목표를 추가할 것인지 결정합니다. 처음에
는 가용성 SLO 테이블에 빈 목표 테이블이 표시됩니다.
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SLM 시나리오
시나리오 5: 계층 필터를 기반으로 서비스 작성
그림 7-138 가용성 SLO 테이블

OVIS ICMP 가용성 측정 항목이 값 0 또는 1을 반환할 경우 서비스 관리자는 
각 측정 항목 정의에 대해 "보다 크거나 같음"이라는 목표 연산자를 지정하며 
이 값은 1입니다. "보다 큼" 연산자를 지정하고 값이 0.5인 경우에도 같은 효과
가 나타납니다.

서비스 관리자는 연산자 열의 드롭다운 목록에서 필요한 연산자를 선택합니다. 
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SLM 시나리오
시나리오 5: 계층 필터를 기반으로 서비스 작성
그림 7-139 가용성 객체 연산자 선택

서비스 관리자는 각 테이블 셀에 필요한 값을 입력합니다.
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SLM 시나리오
시나리오 5: 계층 필터를 기반으로 서비스 작성
그림 7-140 목표 값 지정

다음 그림은 모든 연산자와 값이 추가된 후 테이블이 어떻게 나타날지 보여 줍
니다. 
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SLM 시나리오
시나리오 5: 계층 필터를 기반으로 서비스 작성
그림 7-141 완료된 가용성 SLO 테이블

서비스 수준 계약 관리

결과적으로 서비스 관리자는 SLM 관리 하에 서비스 수준 계약을 두게 됩니다
. 이 작업 처리 방법에 관한 예를 확인하려면 214페이지의 "서비스 수준 계약 
관리"를 확인하십시오.
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